# Table of Contents

**General Overview of PennERA** .............................................................................. 4  
Section Overview ........................................................................................................ 4  
Pre-Award ...................................................................................................................... 4  
Submission of Proposals to Sponsors ........................................................................ 4  
Electronic Notification of Award Notices ................................................................ 4  
Post Award Management .............................................................................................. 4  
Data Reporting for Management ................................................................................. 4  

**System Features and Process Overview** ................................................................. 5  

**Getting Started with Proposal Development** .................................................. 6  
Create Proposals – Process Overview ...................................................................... 6  

**Navigation Features** .............................................................................................. 8  
Common Icons ............................................................................................................. 8  
Logging into PennERA Proposal Development ......................................................... 9  
PennERA Portal ........................................................................................................... 10  
My Action Items and My Messages ......................................................................... 11  
Navigation Menu ....................................................................................................... 11  
Buttons, Drop Down Boxes, Etc. ............................................................................. 12  
Upload Documents, Warnings, etc. .......................................................................... 12  
Completed...................................................................................................................... 13  

**The New Portal** ..................................................................................................... 15  
My Proposals .............................................................................................................. 15  
My Proposals > Show List ......................................................................................... 15  
My Proposals > Search For ......................................................................................... 16  
My Profile .................................................................................................................. 18  
My Profile > General ................................................................................................. 18  
My Profile > Sponsor Credentials ............................................................................. 19  
My Profile > Delegates ............................................................................................. 19  
My Profile > Biosketch .............................................................................................. 20  
My Profile > Resources ............................................................................................. 21  
My Profile > Settings ................................................................................................. 22  
My Action Items ......................................................................................................... 23  
My Messages ............................................................................................................. 23  

**Create New Proposal** .......................................................................................... 25  
Section Overview ....................................................................................................... 25  
Navigation Path: My Proposals > Create New Proposal ...................................... 26  
New Proposal Questionnaire – Steps 1-7 ................................................................. 27  
Step 8 – Setup Questions ......................................................................................... 31  

**Proposal Forms** .................................................................................................... 37  
Overview ..................................................................................................................... 37  
SF424 (R&R) ............................................................................................................... 38  
Performance Sites ..................................................................................................... 40  
Other Project Info ....................................................................................................... 41  
Project Summary ....................................................................................................... 42  
Project Narrative ....................................................................................................... 43  
References Cited ........................................................................................................ 43  
Resources .................................................................................................................. 44  
Other Attachments .................................................................................................... 45  
Budget ......................................................................................................................... 46  
Budget > Budget Items .............................................................................................. 47  
Budget > Budget Items > Personnel Costs .............................................................. 48
Appendix A
How do I... change the PI? .................................................. 85
How do I... add or change default Associated Department? ..... 87
How do I... create a simplified budget? ............................... 88
How do I... budget for F&A exemption expenses like equipment in a simplified budget? ............ 94
How do I... enter genomic array (microarray) expense? ........ 96
How do I... resize scanned documents or odd-sized PDFs? .... 100
How do I... change project/budget period dates or add or remove budget periods? ................. 102
How do I... view the cumulative budget totals? .................... 106
How do I... budget for Academic and/or Summer appointments? ........................................ 109
How do I... copy an existing proposal? ................................. 114
How do I... create Non-Personnel expenses for “Budget by Total Project”? ......................... 116
How do I... manually adjust F&A? ......................................... 118
How do I... use 424 budgeting? ........................................... 122
How do I... print a copy of my proposal? ............................... 128
How do I... view a proposal I’ve been working on? .................. 128
How do I... determine where a proposal is that’s been submitted for internal review? .......... 128

Appendix B: Best Business Practices ........................................ 129
Naming Conventions for files to be uploaded ............................ 129
Working Collaboratively Across Schools .................................. 129

Appendix C: Document Revision History ................................. 130
PennERA Proposal Development Frequently Asked Questions (FAQs) .......................... 131
General Overview of PennERA

Section Overview

Electronic Research Administration (ERA) is the term used to describe the methods of conducting research administration in an integrated and automated environment. In its broadest definition, it encompasses both pre- and post-award processes that involve the administrative and regulatory aspects of sponsored projects. PennERA includes the following (items in **Bold** are included in the current Proposal Development phase):

**Pre-Award**
- Identification of funding opportunities
- Proposal development
- Institutional and faculty profiles
- Approval routing (including regulatory and other approvals)
- Budget development
- Cost sharing information
- Subcontracts tracking

**Submission of Proposals to Sponsors**
- Electronic (to sponsors who have the capability)

**Electronic Notification of Award Notices**
- Automatic notification
- Automated project setup

**Post Award Management**

PennERA feeds this information to other Penn systems, such as the Data Warehouse, for:
- Project financial management
- Sponsor invoicing
- Project closeout and reporting
- Effort reporting

**Data Reporting for Management**
- Timely and accurate reporting at all phases of the project life cycle
- Ability to slice and dice information
System Features and Process Overview

The Proposal Development application provides tools that will improve efficiency and enhance Penn’s ability to obtain funding from sponsors. The Proposal Development Application features include:

- Ability to create proposals electronically
- Ability to electronically assemble proposals
- Ability to route proposals through the approval hierarchy
- Ability to electronically review and approve proposals
- Ability to electronically submit proposals to the sponsor
- System-wide reusability of Profile and department information
- Automatic population of University-wide information (e.g., DUNS#, FWA#)
- Application support of Sponsor-specific form sets
- Ability to track the progress of proposals through the internal review and approval process

The Proposal Development process consists of 6 major tasks:

Proposal Development Process Overview

[Diagram showing the process]

- Investigator
  - Validate Profile Sections
- Investigator and Administrator
  - Create Proposal
- Investigator
  - Finalize and Submit Proposal for Internal Review
- Proposal Reviewer and Approver
  - School Internal Review
- ORS
  - ORS Review
- ORS/Investigator
  - Submit to Sponsor

A complete list of the funding mechanisms that can be prepared and submitted as electronic system-to-system (S2S) proposals via Proposal Development can be found on the PennERA website [PennERA Electronic Submission Reference Materials](#).

- Most competitive proposals that cannot be prepared as S2S submissions via the Proposal Development application are processed PD as generic template records.
Getting Started with Proposal Development

In order to get started with your Proposal make sure you have verified and/or updated your Profile information in PennERA:

- Ensure that your name appears as you prefer it to appear on proposals.
- Verify that your email address is present and correct.
- Verify and, if necessary, correct your NIH Commons ID.
- Verify and, if necessary, correct/enter your FAX #, Title, and County.

An investigator’s name in his/her PennERA Profile is the same as it appears in the Penn Community (typically how the name appears in Payroll). However, the name an investigator uses in the sponsored research community may be different. If an investigator prefers to use his/her professional name on proposals, s/he should manually change the name in the PennERA profile.

**Note:** For all NIH submissions through Grants.gov, your NIH Commons ID and name must be exactly the same as it appears in the NIH Commons. Be sure to check capitalization, as this information is case sensitive.

Investigators should make any changes to their Profile information before they begin using PennERA to create proposals, so that the information will be incorporated into any proposals created.

Create Proposals – Process Overview

Creating a Proposal using the Proposal Development application requires that you complete a series of questions and forms. The Proposal Development application will lead you through the proposal development process and generate the appropriate questionnaires and forms based on the Sponsor you select. The Proposal Development application validates the information you enter and alerts you to any errors or incomplete items.

Once you have completed the various parts of the Proposal, you can assemble the proposal and prepare it for internal review.
How to Get Help with Training

This User’s Guide is designed to let you access any or all of the components listed in the Table of Contents. You can advance through all the sections sequentially or you can jump around from section to section.

If you experience difficulty using any of the training materials, send an email to pennerahelp@lists.upenn.edu with a brief explanation of the problem.

How to Get Help after Training (End User Support)

If you experience a problem or have a question once you have finished training and begin using the Proposal Development application, please take the following steps:

- Use the Support link on the PD application to contact the PD Support Group.
- Send an email with your question or a description of the problem to pennerahelp@lists.upenn.edu.

Institution Number and What It Means

The Institution Number (or Proposal Number) is an automatically generated number specific to PennERA. This number will help users track a proposal throughout its University of Pennsylvania life cycle.

Security

Security within PennERA is role-based. Principal Investigators will have access to any proposal for which s/he is the Principal Investigator. Administrative staff will have access based on pre-defined security roles determined by their Organization.

Delegating Authority

A user may grant another user certain access rights and authority. By doing so, that user may act on your behalf to either view or edit proposals.

- Go to “Profile” and select the “Delegation” function and select the person to whom you are delegating authority

Functions by Role

Depending on your role within the Organization, you will have the ability to perform certain tasks within the Proposal Development application. The chart below provides a high-level description of the roles and associated tasks:

<table>
<thead>
<tr>
<th>Role</th>
<th>Create</th>
<th>Review</th>
<th>Approve</th>
<th>Submit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigator</td>
<td>Create or modify proposals</td>
<td>Submit for internal review</td>
<td>Respond to rejected Proposal</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td>Create or modify proposals</td>
<td>Review Proposals</td>
<td>Approve or Reject Proposals</td>
<td></td>
</tr>
<tr>
<td>Other Approvers</td>
<td></td>
<td>Review Proposals</td>
<td>Approve or Reject Proposals</td>
<td></td>
</tr>
<tr>
<td>ORS</td>
<td></td>
<td>Review Proposals</td>
<td>Approve or Reject Proposals</td>
<td>Electronically submit Proposals</td>
</tr>
<tr>
<td>Other Central Admin</td>
<td></td>
<td>Review Proposals</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Navigation Features**

The **Proposal Development application** has been designed with navigation features that are common in many Windows and Web applications. Read and follow instructions on the screen display. Common navigational conventions are used throughout the application; some examples are described below:

### Common Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Done</td>
<td>Located in the top toolbar, closes the proposal that you’re working on. It is important to click [Done] when finished working with a specific proposal. While multiple users may view and edit different sections within a proposal, only one person may edit a specific proposal page at a time.</td>
</tr>
<tr>
<td>Back</td>
<td>Located in the top toolbar, returns you to the previous page.</td>
</tr>
<tr>
<td>Save</td>
<td>Located in the top toolbar, saves your changes on the current page. This option is available only if you have been assigned Edit access. The system will prompt you to save your changes if you edit a page and fail to use the Save icon when exiting the page.</td>
</tr>
<tr>
<td>Exit</td>
<td>Located in the top toolbar, exits you from the module or the PennERA Portal.</td>
</tr>
<tr>
<td>Help</td>
<td>Located in the top toolbar, points you to InfoEd help modules for general system help.</td>
</tr>
<tr>
<td>Support</td>
<td>Located in the top toolbar, opens to web form where you can request help from PennERA End-User Support providers.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the corresponding item, security level permitting.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the corresponding form or page in edit format, security level permitting.</td>
</tr>
<tr>
<td>View</td>
<td>Opens the corresponding form or page in view format, security level permitting.</td>
</tr>
<tr>
<td>In Use</td>
<td>Indicates that you or someone else is currently working in the proposal.</td>
</tr>
<tr>
<td>Upload</td>
<td>Uploads an attachment located after browsing your directories.</td>
</tr>
<tr>
<td>Replace</td>
<td>Opens the corresponding window in which to replace an existing document with a newer version.</td>
</tr>
<tr>
<td>Remove CV</td>
<td>Removes an uploaded CV (biosketch).</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes an item from the current list or location within a record.</td>
</tr>
<tr>
<td>Completed</td>
<td>Designates a tab (section) that has been completed.</td>
</tr>
<tr>
<td>Access Log</td>
<td>Shows past history of who has accessed a particular section of the proposal.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Indicates if a PennERA site mail message has been opened or not opened. The yellow envelope indicates a message that has not been read. An open white envelope is a message that has been read.</td>
</tr>
<tr>
<td>Run</td>
<td>Runs or creates the desired document from data within the system; used in batch communications.</td>
</tr>
<tr>
<td>Run</td>
<td>Generates a report.</td>
</tr>
</tbody>
</table>
Logging into PennERA Proposal Development

Logon to PennERA Proposal Development from the PennERA home page (https://www.pennera.upenn.edu/).

You will need your PennKey and Password to authenticate and enter the application. Information on PennKey can be found at http://www.upenn.edu/computing/pennkey/.

- Click [LOGON].
- Type your PennKey and Password.
- Click [Submit] to authenticate.
PennERA Portal

The PennERA Portal Page is the point of entry into the PennERA Proposal Development system.

- Under the PennERA logo at the top of the PennERA Portal Page is the Toolbar.
- The navigation bars on the left and right sides of the screen are used to access the different PennERA modules.
- When you click any one of the Toolbar links or the Personal Side Bars, the system displays that page.

1. Toolbar for Exit, Help, Support
   - **Exit** – sign-off and exit the application
   - **Help** – provides context-sensitive vendor supplied (non-Penn specific) help text
   - **Support** – opens the Penn Help Desk web form to report any problems

   The toolbar in proposal records has additional icons:

   ![Toolbar Icons]

   - **Done** – click to exit a proposal record
   - **Show** – click to display context-sensitive help

2. **My Proposals** – Create new proposals, search for existing proposals, and context-sensitive, vendor-supplied (non-Penn specific) help guides.

3. **My Profile** – All PennERA users have a profile with basic address and contact information provided from the Penn Community directory that you should verify and update. See also “Getting Started with Proposal Development” for additional information.

4. **Find Funding** – Opens the SPIN (funding opportunities) and SMARTS (funding opportunities email alert service) databases, enabling easy access to new funding opportunities.

5. **CV Database** – Opens the GENIUS CV Database for collaborative efforts.

6. **My Action Items** – Items requiring user action, for example, review and approval of proposals. ‘My Open Action Items’ are automatically displayed when the portal screen is first displayed after login.

7. **My Messages** – Messages received from the PennERA internal messaging system.
My Action Items and My Messages

PennERA messages are site mail or messages sent within the PennERA application. Users who are required to approve a proposal will be sent a University e-mail and may access the proposal to be approved from the PennERA message center (My Messages) or through My Action Items. Users may message other PennERA users using site mail as well as respond to proposals routed for approval/review via the messaging system. As e-mail clients are currently the standard accepted business communication application, the use of PennERA site mail is not recommended at this time.

**Navigation Menu**

After logging onto the Proposal Development application, the Main Menu, referred to as the Navigation or Nav Menu, is located on the left and right sides of your screen.

1. To expand a Menu Option, click on the menu item.
2. Additional submenu items are displayed on the Navigation menu.
3. Navigate to proposals from either Show/List (for PIS) or Search For in My Proposals.
**Buttons, Drop Down Boxes, Etc.**

**Action buttons** allow you to process within the screen. Click on the button to initiate the appropriate action.

```
Set  Go  Close
```

**Radio Buttons** are for unique selections. Click on the button to select an item or answer a question.

- Will your proposal involve the use of Laboratory Animals?
- Will your proposal involve multiple principal investigators?

**Drop down boxes** are for selection. To use a drop down box, move the cursor over inverted triangle and click to allow drop down selections to appear. Click to select the appropriate item.

**Alpha split lists** are used to locate Proposals, PI names, and staff information.

Select a letter; use the drop down box or search for a particular entry by typing person’s name. Highlight the desired entry and click [Select].

**Upload Documents, Warnings, etc.**

**Upload Documents**

You will be required to upload documents at various points in the Proposal Development process. Below are instructions for completing a document upload:

- Click [Browse].
- Find the appropriate file on your computer.
- Change document name if necessary (e.g., Project Narrative for 10009452).
- Click the **Upload** icon.

*All uploaded documents will be automatically converted to PDF.*
The successfully uploaded document can be **Viewed** or **Removed**.

<table>
<thead>
<tr>
<th>View</th>
<th>Pages</th>
<th>Remove</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(1)</td>
<td></td>
</tr>
</tbody>
</table>

**Upload “Project Summary” Documentation**

![Browse...]

**Note:** Documents uploaded to Proposal Development are stored in PDF format. View your uploaded documents to ensure special characters, figures, pictures, etc., are captured correctly.

*********************************************************************

**Warning and Error message boxes**

The application dynamically checks your entries and alerts you to items that are incorrectly entered or items that you fail to enter but that are required.

**Completed**

**Completing each section of the proposal**

- As you complete each section of the Proposal, click the **Save** icon in the upper left corner of the screen. This will save all data entered onto that form or page.
- After saving the data, check the box in the upper right corner **“Completed”**. A red check mark appears next to the completed sections on the Navigation Menu. This red check mark indicates these sections or forms have been completed and “checked in” to the application.
**Note:** Be patient when saving data or completing the form. Make sure the application has completed the last action and has finished refreshing the screen before moving to the next step.

- To edit a previously completed form, the form must be “checked out”. Select that form from the Navigation Menu, click to uncheck the “Completed” box, and make edits as necessary. It will be necessary to Save and Complete the form again.

Exiting a proposal record

- When finished working with a proposal click the Done icon in the top toolbar.
- The Proposal Development application will allow concurrent edit access to more than one person, although in the current software version, only one person at a time can effectively edit a proposal section.

**Note:** It is very important to click when finished working with a specific proposal so that others may gain edit access to the entire proposal.
The New Portal

Section Overview – The new portal view replaces the Personal Menu and allows each user to send/receive messages internal to PennERA, maintain a profile, view and create proposals, and modify view settings.

Features

- My Proposals – create new, view, edit and/or delete existing proposals; obtain online Help information (non-Penn specific).
- My Human Subjects and My Animal Use – view human subject and animal use protocols.
- My Profile – update and maintain profile information and change portal settings.
- My Action Items – Items awaiting the user’s review and/or approval, such as proposals.
- My Messages – PennERA generated electronic communications. If authority has been delegated, the name of both the person who delegated authority and the name of the person to whom authority has been delegated appear here. You are able to access messages for both names.
- Find Funding – find funding opportunities by connecting to SPIN or SMARTS databases.
- CV Database – log onto GENIUS database to find, update and maintain CVs.

My Proposals

Overview

This section provides links to search for, view, and edit existing proposals and to create new proposals.

- Show/List – displays a list of all proposals for which the current user is the PI.
- Search For – displays various search options to locate proposals.
- Create New Proposal – start new records.
- Help – online User Guides provided by Info Ed (not Penn-specific).

My Proposals > Show List

Click on this link to display a list of all proposals for which the current user is the Principal Investigator. The information in the results lines displayed is the same as search results (see next section).
My Proposals > Search For

Click this link to display a search screen.

Features

- Frequently searched fields are initially displayed.
- Click on “Show Additional Search Options” to display more search field.
- Can use wildcards in most fields.
- In most text fields, there is the option to enter information or select from a picklist.
- All column headings for results may be sorted in ascending or descending order. Default sort is by Title.
- Results lines contain information about the proposal, either displayed or available in “mouseover” icons.
Sample Results

<table>
<thead>
<tr>
<th>Institution Number</th>
<th>Proposal Type</th>
<th>Title of PI</th>
<th>Current Prime Fund #</th>
<th>Award Number</th>
<th>Requested Period</th>
<th>Awarded Period</th>
<th>Sponsor Department</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>10023250</td>
<td>v12.800.02 PT testing with PD proposal</td>
<td>FRATANTARO, STEPHEN</td>
<td>01-Jul-2011 - 30-Jun-2016</td>
<td>01-Jul-2011 - 30-Jun-2016</td>
<td>NATIONAL INSTITUTES OF HEALTH</td>
<td>4102 - BB-Biochemistry and Biophysics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10023428</td>
<td>v12.800.03 PT Test Plan Scenario IA</td>
<td>FRATANTARO, STEPHEN</td>
<td>01-Nov-2010 - 31-Oct-2012</td>
<td>01-Nov-2010 - 31-Oct-2012</td>
<td>NATIONAL INSTITUTES OF HEALTH</td>
<td>4102 - BB-Biochemistry and Biophysics</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Proposal Status: Awarded
Status Date: 25-Aug-2010
My Profile

Overview

Your PennERA profile can be used to manage a variety of information including: biosketch, employment and education history, etc. Select the appropriate menu option to open screens that allow you to add/update this information.

My Profile > General

Overview

All PennERA users have a profile with address and contact information that is initially setup from their Penn Community information and continues to be updated nightly from the online directory. Changes to your profile general information should be made through the online directory whenever possible.

Note: Making a change directly to your PennERA profile will disable the nightly update from the Penn Community.

REQUIRED fields – Address, city, state, country, Email, and phone information are required fields for submission of electronic proposals.

Note: Title, fax, and county are no longer required for NIH electronic submissions. However, it is recommended that users supply information for all the fields in their profiles, as these validations may change and also may be required as other sponsors are included in the electronic submission process through Proposal Development.

• Click Save to save any changes you have made to your profile in the PennERA system.
My Profile > Sponsor Credentials

Overview

NIH (eRA Commons and NSF (FastLane) require certain identities in order to submit proposals. This information can be entered in this section.

<table>
<thead>
<tr>
<th>Credential</th>
<th>Credential Type</th>
<th>Sponsor</th>
<th>Edit / View</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>FORDEJ</td>
<td>NIH Commons ID</td>
<td>NATIONAL INSTITUTES OF HEALTH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NSF FastLane ID</td>
<td>NATIONAL SCIENCE FOUNDATION</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

My Profile > Delegates

Overview

The Delegation menu option allows the user to delegate access to his/her items to another individual within PennERA. This function is particularly useful when the user is out of the office for a long period of time.

Features

- Select [Add] to create delegates from the PennERA community.
- From the Alpha list choose the name of the person you wish to grant access.
- Delegate the appropriate level of authority
  - View or Edit proposals
  - View, Edit, Add, and/or Delete items from the Calendar.

Click Save to save changes.
My Profile > Biosketch

Overview

This screen allows you to create your biosketch from information you enter within your profile.

Features

- Fill out information pertaining to your Education, Employment, Publications, etc., in the appropriate submenu options.
- Select [Create New] to create your Biosketch from the information entered.
- View the PDF, replace, edit or [Delete] existing Biosketches.
- [Upload New] Biosketch information from existing files.
My Profile > Resources

Overview

This section allows the user to enter Resource information directly into their profile. When creating proposals, information entered here may be used in the Resources form (if applicable). Common practice is to upload Resources information as Word documents that will be converted into PDF forms.

<table>
<thead>
<tr>
<th>Resource Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laboratory</td>
</tr>
<tr>
<td>Clinic</td>
</tr>
<tr>
<td>Animal</td>
</tr>
<tr>
<td>Computer</td>
</tr>
<tr>
<td>Office</td>
</tr>
<tr>
<td>Other</td>
</tr>
<tr>
<td>Major Equipment</td>
</tr>
</tbody>
</table>
My Profile > Settings

Overview
This section allows the user to modify some display options.

Features

- **Portal Login** – Only “New” portal view is now available in PennERA.
- **Results per Page** – Choose the maximum number of items to be displayed in search results.
- **Web Portal Tabs** – By default, “My Projects” and “My Calendar” are not visible as these functions are not currently used. Users may also turn off other portal tabs they are not using.
- **Color Schemes** – Choose the browser window color scheme.
- Click Save.
My Action Items

Overview

Action Items are items awaiting the user’s review and/or approval, such as proposals.

- Click on to open the Review Dashboard under ‘My Open Action Items’.
- Previously reviewed and completed items may be viewed by clicking on ‘Completed’ under ‘My Action Items’.

<table>
<thead>
<tr>
<th>My Open Action Items</th>
<th>Item</th>
<th>Type</th>
<th>Outstanding reviews</th>
<th>Action Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thursday, August 26, 2010</td>
<td>Proposal - 30022224</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monday, August 23, 2010</td>
<td>Proposal - 30022243</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

My Messages

Overview

PennERA has internal messaging or site mail. Each user has a mailbox within PennERA that allows the user to send/receive messages to other users within the PennERA community.

In certain instances PennERA will automatically generate a PennERA message as well as send a University e-mail:

- When a proposal has been routed to an individual for review or approval
- If a proposal is returned to you for changes or correction

Features

Below is an example of an “Approval Needed” message. At the top of the message are icons that will allow you to manage your messages. In the body of the message are links to view the proposal, or open the reviewer dashboard to approve or disapprove the proposal.
Open Reviewer Dashboard to enter decision (if an approver)

Open Proposal (security rules determine who can access)
Create New Proposal

Section Overview

The Proposal Development application will generate the appropriate forms based on the Sponsor you select. The Navigation Menu will display the forms that are needed for the type of proposal you want to create. Below is an example of how the Navigation Menu changes based on sponsor:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Questions</td>
<td>Setup Questions</td>
<td>Setup Questions</td>
</tr>
<tr>
<td>SF424 (R&amp;R)</td>
<td>SF424 (R&amp;R)</td>
<td>Abstract</td>
</tr>
<tr>
<td>Performance Sites</td>
<td>Performance Sites</td>
<td>Personnel</td>
</tr>
<tr>
<td>Other Project Info</td>
<td>Other Project Info</td>
<td></td>
</tr>
<tr>
<td>Project Summary</td>
<td>Project Summary</td>
<td>Budget</td>
</tr>
<tr>
<td>Project Narrative</td>
<td>Project Narrative</td>
<td>Budget Items</td>
</tr>
<tr>
<td>References Cited</td>
<td>References Cited</td>
<td>Cost Sharing</td>
</tr>
<tr>
<td>Resources</td>
<td>Resources</td>
<td>Justifications</td>
</tr>
<tr>
<td>Other Attachments</td>
<td>Other Attachments</td>
<td>Versions</td>
</tr>
<tr>
<td>Personnel</td>
<td>Personnel</td>
<td>Budget Periods and Setups</td>
</tr>
<tr>
<td>Budget</td>
<td>Budget</td>
<td>Supporting Documents</td>
</tr>
<tr>
<td>Budget Items</td>
<td>Budget Items</td>
<td>Research Plan</td>
</tr>
<tr>
<td>F&amp;A</td>
<td>F&amp;A</td>
<td>Approvals</td>
</tr>
<tr>
<td>Cost Sharing</td>
<td>Cost Sharing</td>
<td></td>
</tr>
<tr>
<td>Modular Budget</td>
<td>Justifications</td>
<td></td>
</tr>
<tr>
<td>Justifications</td>
<td>Versions</td>
<td></td>
</tr>
<tr>
<td>Versions</td>
<td>Budget Periods and Setups</td>
<td></td>
</tr>
<tr>
<td>PHS 398 Cover Page</td>
<td>NSF Cover Sheet</td>
<td>Approval</td>
</tr>
<tr>
<td>PHS 398 Research Plan</td>
<td>NSF Suggested Reviewers</td>
<td>Internal Documents</td>
</tr>
<tr>
<td>PHS 398 Checklist</td>
<td>Appendix</td>
<td></td>
</tr>
<tr>
<td>PHS 398 Cover Letter</td>
<td>Internal Documents</td>
<td></td>
</tr>
<tr>
<td>Approvals</td>
<td>Approvals</td>
<td></td>
</tr>
<tr>
<td>Internal Documents</td>
<td>Finalize</td>
<td></td>
</tr>
<tr>
<td>Finalize</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Features

- The Proposal Development application will lead you through the steps that are necessary to satisfy the requirements specified by the sponsor. The Navigation Menu represents those defined steps. Different sponsors have different requirements. The Navigation Menu changes based on the sponsor.
- Each submenu must be completed in order to “Finalize” the proposal, but the forms do not have to be completed in sequential order.
Navigation Path: My Proposals > Create New Proposal

Process Overview

The “create a proposal” process consists of four basic steps, with the addition of the appropriate Sponsor-required forms:

Create a Proposal

In order to get started with your Proposal, you need to do the following tasks:

4. Profile update
   - Verify and/or update your Profile information in PennERA (especially NIH Commons and NSF FastLane identities, name, address, city, state, country, phone, email).
   See also Profile for more information.

5. Begin preparing Word or PDF documents that will be uploaded to the proposal. Required documents will vary by sponsor and may include some or all of the following:
   - Project Summary
   - Information on use and treatment of human subjects and/or vertebrate animals
   - CVs/biosketches and/or Other Support for Key Personnel
   - Project Narrative
   - Resources
     - Facilities and Other Resources
     - Major Equipment
   - References Cited
   - Additional attachments if needed

Note: If your document uses a symbols or complex graphics, please convert the document to PDF format before uploading to ensure that these elements are correctly converted.
New Proposal Questionnaire – Steps 1-7

Overview

When creating a new proposal, you are prompted through a series of seven set-up questions that enable you to launch into the proposal creation process. After completing those seven steps, you will not be able to return to this form again, but you will be able to change the information on other screens.

*Note:* There are [Cancel] and [Back] buttons on each screen within the questionnaire. Use [Back] to go back one or more steps if you need to change a previous answer.

---

Step 1 – Determine PI, initiate proposal creation

Features

- Change the PI
- Create a new proposal or copy an existing one

---

Change PI

- The “PI” defaults to the user.
  - If creating a proposal for someone else, click [Change PI].
  - Choose the new PI from the Alpha-split list, click [Select].
- If you are creating a proposal for another PI, you cannot “Submit” the proposal.
- PIs must submit proposals under their name.

---

Do you want to...

- Determine if this proposal is a “New” proposal or a “Copy from Existing” proposal.
- Select the appropriate proposal type from the “Do you want to...” box.
  - Only those proposals created in Proposal Development are available to be copied.
  - You can copy only those proposals that you have access to as defined by system security rules.
- See also Appendix A, “How Do I... copy an existing proposal?”
- Click [Continue to Next Step].
Step 1 Continued… – Find Funding Opportunity

Features

- Allows access to SPIN funding database, if necessary.

Select from Grants.Gov Opportunities

Features

- Allows search of the Grants.Gov funding database using keyword search criteria from the full program, title, or funding opportunity number.

**Note:** Although there are several options for locating the Funding Opportunity Announcement, the method presented here is recommended.

*Funding Opportunity Numbers should not be retrieved for non-S2S Federal proposal records set up as generic records.*

- Type in the search criteria. Examples:
  - Funding Opportunity Announcement Number: “PA-10-067”
  - Part of the Opportunity Title: “Parent R01”.
  - Can also enter keywords.
  - “S2S” is selected by default.
- Click [Search].

*Wait for the screen to refresh with the program information.*
Click **Select** below the appropriate Opportunity Number.

**Step 2 – Select New Competing or Competitive Renewal**

- Review the information displayed in Step 1 for the selected Program Number.
- Determine if this proposal is a **New Competing** or **Competitive Renewal**.
- Click [**Continue to Next Step**].

**Step 3 – Select a Sponsor**


Click **SPIN** to see more information about that program.
Step 4 – Proposal Number (also called institution number)

Will be automatically numbered by the system once the set up questionnaire has been completed.

**Note:** If you are requested to manually enter a Proposal Number, please stop, click [Back] to Step 2 and repeat. If manual input is again requested, stop and send e-mail to PennERAhelp@lists.upenn.edu.

Step 5 – Enter the Proposal’s Title

- Enter the title of your proposal.
- Click [Continue to Next Step].

Step 6 – Enter Project Dates

- Enter the project dates using a MMDDYY format (e.g., “080109”); system changes date format to DD-Mon-YYYY) or select the date from the calendar tool.

```
040109 [ ] through [ ] 01-Apr-2009 [ ] through 033114 [ ]
```

**Note:** Some Proposal types validate date information based on Sponsor Mechanism Type.

- Click [Continue to Next Step].

Step 7 – Confirm Budget Periods, Create Proposal

**Features**

- Confirm the number of budget periods based on the Project Start and End dates from Step 6.
- Create the proposal.
How many years and/or budget periods would you like?

- Confirm the number of budget periods you are requesting.
- Click [Continue to Next Step].

<table>
<thead>
<tr>
<th>Step 0</th>
<th>Confirm you intend for the PI of this proposal to be Ford, Evelyn J - or - Change PI, now please</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>“New” or “Copy From Existing”? Create a New Proposal</td>
</tr>
<tr>
<td></td>
<td>Program Number</td>
</tr>
<tr>
<td></td>
<td>PA-10-067</td>
</tr>
<tr>
<td>Step 2</td>
<td>Proposal Type</td>
</tr>
<tr>
<td>Step 3</td>
<td>Selected Sponsor</td>
</tr>
<tr>
<td></td>
<td>Mechanism</td>
</tr>
<tr>
<td>Step 4</td>
<td>Tracking Number or “Proposal” Number</td>
</tr>
<tr>
<td>Step 5</td>
<td>Proposal’s Title</td>
</tr>
<tr>
<td>Step 6</td>
<td>Project Start and End Dates</td>
</tr>
<tr>
<td>Step 7</td>
<td>Number of Budget Periods</td>
</tr>
<tr>
<td>Is all of the above information correct?</td>
<td>Yes, Create Proposal</td>
</tr>
</tbody>
</table>

Is all of the above information correct?

- Review the information you entered and click [Yes, Create Proposal] to continue or [No, Go back...] if you need to make changes to any of the earlier steps.
- The application automatically assigns a Proposal Number (i.e., Institution Number) when you complete this step.

Please be patient while the proposal is processing. Once processed, Setup Questions page will load.

**Step 8 – Setup Questions**

**Overview**

The Setup Questions (Step 8) provide questions/answers that enable the Proposal Development application to determine and present the appropriate screens for subsequent parts of the proposal. Answer the questions based on your knowledge of the proposal. Setup questions vary by Sponsor and Mechanism Type. Many of the answers are pre-filled based on the type of funding program selected.

**Features**

- Subsequent forms will reflect the type of information you enter here.
- Some information is pre-entered based on the program you have chosen but all information can be changed if the pre-entered answers do not reflect the facts about the project.
- Some information needs to be completed, see below:
1. Submission Mechanism/Form Information

Submission Mechanism/Form Information

Proposal Sponsor is set to **NATIONAL INSTITUTES OF HEALTH**. Click here to change.

Please select a Submission Mechanism/Screen Template: 424 R&R NIH (electronic submission)

Opportunity Number: PA-10-067

- **Submission Mechanism/Screen Template** is pre-populated based on the type of grant.
  - If this is an application that will be directly submitted to Grants.Gov from PennERA Proposal Development (system-to-system, or S2S), the template should be a 424 R&R electronic submission.
  - If this not an S2S proposal, the template should be UPENN – Generic Template.
- In the electronic submission process, all Grants.gov proposals are considered solicited and should have a Funding Opportunity Announcement number.
  - For NIH investigator-initiated proposals, there is a parent or umbrella funding opportunity that is the equivalent of the “unsolicited” proposal in the paper submission process.
  - NIH Parent Announcements can be found at NIH Parent FOAs.
  - Generic records should never have an opportunity number entered.
- Verify the the correct **Opportunity Number** is present.
  - Click **Get Opportunity Link** if this number must be changed.

2. Grants.Gov Submission Information

- Information will auto-populate based on the Opportunity Number
- Review information for accuracy and to ensure that proposals are still being accepted (Opportunity Open and Close Dates).
- Click on **Mechanism Opt In/Out** to opt out of validations that do not apply to this proposal’s requirements.
- Forms are selected by PennERA based on the opportunity chosen and the answers to questions on this tab. These are not editable.
- After all questions are answered, check this section to ensure all required forms are listed and checked as “Included”.

<table>
<thead>
<tr>
<th>Form</th>
<th>Version</th>
<th>Included</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHS398 Checklist</td>
<td>PHS398_Checklist_1_3-V1.3</td>
<td>✅</td>
</tr>
<tr>
<td>PHS398 Cover Page Supp</td>
<td>PHS398_CoverPageSupplement_1_4-V1.4</td>
<td>✅</td>
</tr>
<tr>
<td>PHS398 Research Plan</td>
<td>PHS398_ResearchPlan_1_3-V1.3</td>
<td>✅</td>
</tr>
<tr>
<td>Performance Site</td>
<td>PerformanceSite_1_4-V1.4</td>
<td>✅</td>
</tr>
<tr>
<td>Key Person Expanded</td>
<td>RR_Expanded_1_2-V1.2</td>
<td>✅</td>
</tr>
<tr>
<td>Other Project Info</td>
<td>RR_OtherProjectInfo_1_3-V1.3</td>
<td>✅</td>
</tr>
<tr>
<td>RR_SF424</td>
<td>RR_SF424_1_2-V1.2</td>
<td>✅</td>
</tr>
<tr>
<td>PHS398 Mod Budget</td>
<td>PHS398_ModularBudget-V1.1</td>
<td></td>
</tr>
<tr>
<td>PHS398 Cover Letter</td>
<td>PHS_CoverLetter_1_2-V1.2</td>
<td></td>
</tr>
<tr>
<td>Budget</td>
<td>RR_Budget-V1.1</td>
<td></td>
</tr>
</tbody>
</table>

### 3. Deadline Information

- Always provide a deadline date for all proposals.
- Check pre-populated dates for accuracy. Information will auto-populate based on the Opportunity Number if this is an S2S submission.
- Information can be overwritten if necessary.
- Refer to the applicable Program Announcement to verify the submission deadline date, time, and deadline type. The Deadline Time Zone for Penn is Eastern Standard Time.

### 4. General Proposal Properties

- Answer the questions “Yes” or “No” by clicking in the appropriate radio button.
- Information in this section will drive the budget information and the need to add protocol information for human subjects or vertebrate animals.
- Add or change the default associated department (see Appendix A for more complete details)
  - The Associated Department will default to the PI’s Payroll Home Department information.
  - Adjust if this is not the administering department (i.e., responsible org).
  - Add any org for which a subaccount will be issued if the proposal is funded.
  - PI Department is not editable as this is not related to account setup.
- Proposal can be linked (for informational purposes) to an existing proposal record, if desired.
5. PHS/NIH Questions (if a PHS/NIH Grant)

- Answer the questions “Yes” or “No” by clicking in the appropriate radio button.
- **Modular budget** – generally used for application requests of $250,000 or less in direct costs per year and also as required or prohibited by a specific opportunity announcement (FOA).
  - Answer “Yes” or “No” to whether this is a Modular budget or not.

<table>
<thead>
<tr>
<th>Because you indicated that this proposal is to PHS/NIH …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>Will this proposal involve human embryonic stem cells?</td>
</tr>
<tr>
<td>Is this proposal funding a Clinical Trial?</td>
</tr>
<tr>
<td>Is this proposal an NIH-defined Phase III Clinical Trial?</td>
</tr>
<tr>
<td>Will this proposal be using a Modular budget?</td>
</tr>
</tbody>
</table>

6. Budget Setup Information

- Select either “Budget by Total Project” or “Budget Period by Period”
  - **Budget Period by Period**
    - Budget expense by each period
    - Best option if effort and/or non-personnel expense will vary in most budget periods of the project.
  - **Budget by Total Project**
    - Budget expense on a project basis
    - Best option if the only change to expenses in each budget period is primarily for inflation.
  - **424 Budgeting**
    - Primarily a data entry method
    - Does not calculate fringe benefits or inflationary increases
    - Does not evaluate for the NIH cap
    - Requires more data entry than either of the other two budget methods

- Program Type – select the type of project from the drop down box
- Indicate where the majority of the work will take place – on or off Penn’s campus.

*Note: This information will select the appropriate template for calculation of the F & A (Facilities & Administrative) costs for the budget*
7. Cost Sharing Information

This section can be used to change default settings for cost-sharing information. Based on the Funding Opportunity selected, information about limitations imposed by the sponsor on total project costs will also be displayed here.

- Cost Sharing defaults to the Primary Associated Department (Resp Org).
- Defaults to the PI’s Department for unreimbursable/unallowable costs.
- Different Orgs can be chosen if they are accepting these costs.
  - Click Set to open drop-down alpha-numeric search list to select another Org that would be responsible for cost-sharing or unreimbursable/unallowables costs.
  - Search by Org # not department name.
  - Select the Org that will share the expenses.
  - When you begin to enter the budget, you can enter the account numbers associated with these Orgs.

- Accept or change the answers to the additional questions regarding funding.
- Complete the information box Other funding guidelines/restrictions/information, if necessary, as it applies to the proposal.
  - Use this section to provide any information about Funding Opportunity Announcement numbers for generic records for non-S2S federal-sponsored proposals.

Note: Do NOT enter salary caps or annual project limitations (e.g., $250,000/year for modular budgets). All of these limitations are incorporated in the validations that Proposal Development uses to build the budget. If you plan to enter other funding caps or ceilings, please consult with the PennERA Help Desk before entering any values.

- Click [Save and Continue] when all questions have been answered.
Proposal Forms

Overview

You can upload many of the documents that are required for your Proposal. Other forms require you to enter the data directly into the Proposal Development application. Before you begin your entry, make sure you have the relevant information at hand for things like: resources, budget information, key people, etc.

As you proceed through the Proposal Forms, you can stop and save your work at any time and return to it later. Always click on the Done icon to exit when you are finished working on the proposal.

The Sponsor that you select for your Proposal will cause the Proposal Development application to generate the appropriate forms for that Sponsor. The Navigation Menu on the left reflects the forms that are specific to the Sponsor you select. You must complete all the forms that your Sponsor requires before you can assemble and route your Proposal.

Although the forms vary from Sponsor to Sponsor, generally speaking, all proposals will need several forms that describe what the proposal is about, who will be doing the work, projected costs, outcomes, etc.

The following pages in this section use the SF424 (R&R) forms as required by the sponsor NIH to illustrate system features, processes, and procedures. The use of other sponsors, while displaying a different set of forms, will be processed in the same way, using the same system features, functions, and procedures.

Toolbar

Features

Toolbar is available on all proposal tabs.

- **Done** – Click to exit the proposal record. **Required in order to correctly exit a proposal record. Exiting (logout) PennERA does not immediately remove user from record access**
- **Back** – Navigate to the previous screen if this button is active.
- **Save** – Proposal Development will ask you to save if needed, but click on this icon if in doubt.
- **Help** – Connect to InfoEd documentation available for download.to a local drive.
- **Support** – File a help request with the PennERA Team.
- **Show** – Display context-sensitive help.
SF424 (R&R)

Overview

This is the face page for the application. Most of the information is derived from the **Setup Questions** answered by the user and administrative set-ups provided by ORS.

- Required fields, highlighted in yellow on the screen, must be answered to complete this form.
- Click **Save** before moving to the next step.

<table>
<thead>
<tr>
<th>SF424 (R&amp;R)</th>
<th>Completed</th>
</tr>
</thead>
</table>

### 1. TYPE OF SUBMISSION:
- Pre-application
- Application
- Changed/Corrected Application

### 2. DATE SUBMITTED

### 3. DATE RECEIVED BY STATE

### 4. APPLICATION IDENTIFIER

<table>
<thead>
<tr>
<th>Application Identifier</th>
<th>State Application Identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>19023406</td>
<td></td>
</tr>
</tbody>
</table>

### 5. APPLICANT INFORMATION

- **Legal Name:** The Trustees of the University of Pennsylvania
- **Department:** 4102 - BS-Biochemistry and Biophysics
- **Office:** Office of Research Services
  3451 Walnut Street
  Santa P-221
  Philadelphia PA 19104-6205
  U.S.A.
- **Province:**

<table>
<thead>
<tr>
<th>Prefix</th>
<th>First Name</th>
<th>Middle Name</th>
<th>Last Name</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mr.</td>
<td>PAMELA</td>
<td></td>
<td>CAOULL</td>
<td></td>
</tr>
<tr>
<td>Phone Number:</td>
<td>Fax Number:</td>
<td>Email:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>215-573-6706</td>
<td>215-990-9700</td>
<td><a href="mailto:penmra_notifications@lists.upenn.edu">penmra_notifications@lists.upenn.edu</a></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 6. EMPLOYER IDENTIFICATION NUMBER (EIN):

| EIN | 123123268541 |

### 7. TYPE OF APPLICANT:

- Private University

### 15. PROJECT DIRECTOR/PRINCIPAL INVESTIGATOR CONTACT INFORMATION

<table>
<thead>
<tr>
<th>Prefix</th>
<th>First Name</th>
<th>Middle Name</th>
<th>Last Name</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>LISA</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Position/Title</th>
<th>Organization Name</th>
<th>Department</th>
<th>Division</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN &amp; FINANCIAL OFFICER</td>
<td>The Trustees of the University of Pennsylvania</td>
<td>4102 - BS-Biochemistry and Biophysics</td>
<td>None</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address (street, city, county, state, zip/postal code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MEC BIOCHEMISTRY</td>
</tr>
<tr>
<td>3820 HAMILTON WY</td>
</tr>
<tr>
<td>PHILADELPHIA PHILADELPA PA 19104-6089</td>
</tr>
<tr>
<td>U.S.A.</td>
</tr>
</tbody>
</table>

| Province | |
|----------| |

<table>
<thead>
<tr>
<th>Phone Number:</th>
<th>Fax Number:</th>
<th>Email:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><a href="mailto:penmra_notifications@lists.upenn.edu">penmra_notifications@lists.upenn.edu</a></td>
</tr>
</tbody>
</table>

### 12. ESTIMATED FUNDING:

a. Total Federal Funds Requested $ 0.00
b. Total Non-Federal Funds $ 0.00
c. Total Federal & Non-Federal Funds $ 0.00
d. Estimated Program Income $ 0.00

Note: Most information is pre-populated.

**Remember to check completed when finished with the form.**
Complete Section 19
- Click in any highlighted yellow field.
- Select the **Official Signing for Applicant Organization**. Choose the person who usually signs your proposals.
- Click [Set], wait for the information to appear, then click [Back].

To finish the form:
- Click ️ [Save], then check the ✓ **Completed** box at the top of the form.
Performance Sites

Overview

Performance Sites is an editable screen where you provide information about where the research is to be performed.

Features

- Change the first site to the primary associated department address.
- Change or add additional performance sites as needed.
  - Subcontract sites will be added automatically as you add subcontracts in the budget.
  - Return to this screen when the budget is completed to enter the subcontract addresses.
- Click Save
- Check Completed
Other Project Info

Overview

Answer questions pertaining to human subjects, vertebrate animals, etc.

Features

- The questions on this screen are brought over from the Setup Questions. If you are unable to change an entry on a particular question on this page, return to the Setup Questions (uncheck Completed on the Setup Questions) and correct the Setup Questions accordingly.
- Answer questions as needed.
- Click Save
- Check ✔ Completed

Assurance numbers are pre-populated.
Project Summary

Overview

This screen gives you the option of uploading your project summary or entering it directly into the Proposal Development application. Manual entry may be too limiting in some circumstances so it is recommended that you upload a pdf document that meets the sponsor guidelines.

Features

- Choose [Upload Document]
- Click [Browse...] to locate a document to upload.
- Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click icon to upload the document
- View the PDF file or remove the document if necessary

Best Practice Hints for naming your documents on your computer

- Create separate folders on your computer for each proposal
- Include the Proposal number in the document name
- Include a version number or date in the file name if there are multiple versions of the same document
- Some sponsors do not allow special characters or spaces in the document name. Refer to sponsor guidelines for requirements.
Project Narrative

Overview – Upload document screen

Features

- When you upload a document, it is a good practice to "name" the document (refer to Navigation Features for details).
- Name the narrative (use the proposal number or some other identifying feature)
- Click [Browse…]
- Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click icon to upload the document
- Click Save
- Check Completed

References Cited

Overview – Upload document screen

References Cited

All uploaded documents will be automatically converted to PDF.
Features

- Click [Browse…]
- Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click icon to upload the document
- Click Save
- Check Completed

Resources

Overview

This is where the resources available, “Facilities & Other Resources” and “Major Equipment” to the project are entered. This page provides the option of uploading an existing document, selecting information from the database, or manually entering information.

*Note:* Due to number of character limitations, it is highly recommended that project resources be uploaded as a document and not selected from the database or manually entered.

Features

- Upload of "Facilities and Other Resources” and “Major Equipment” documents must be completed.
- Choose [Upload Document]
- Click [Browse…] to locate a document to upload.
- Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click icon to upload the document
- View the PDF file or remove the document if necessary
- Click Save
- Check Completed

*Note: Use the Database* – information can be uploaded from the Profile database or manually entered but characters/spacing is limited.
Other Attachments

Overview

Upload any additional documents that need to be sent to the sponsor such as previous correspondence with the sponsor or materials specified by the sponsor in the Program Announcement.

![Image]

Note: Be sure to review the sponsor’s instructions. Many sponsors limit what may be uploaded this tab or provide other detailed instructions about special uploads.

Features

- This is the only form that does not have to be completed (red check beside it) in order to finalize the proposal.
- Good business practice to check “Completed” on all of the forms as a way to verify that you have intentionally not attached a document here.
- If there are forms to be added, Click [Browse...]
- Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click icon to upload the document
- View the PDF file or remove the document if necessary
- Click Save
- Check Completed
Budget

Overview

The Budget section has a sub-menu that lists all the forms related to the budget. In general:

- There are three types of Budget Items: personnel costs, non-personnel costs and subcontractor costs (which consist of personnel costs and non-personnel costs).
- There are 3 roles that can be used to identify the personnel: key personnel, significant contributor, and non-key personnel.
- There are 2 types of non-personnel costs: current expenses and subcontractors (which have personnel and non-personnel costs).

Click on "Budget" on the left-hand Navigation menu to open the Budget sub-menu. Several steps are required to enter the necessary budget data.

Features

- The budget sub-menu items **Budget Items, F & A, Cost Sharing** and **Modular Budget** (if required) must be entered in the order in which they appear.
- **Budget Periods and Setups** -- Use form to add or delete budget years, change budget type/dates, and/or the PI information. This information is completed with information from the other budget sub-forms, but the form can be completed first if information needs to be added, deleted and/or changed.
- Multiple budget periods can be entered at one time.
- Various versions of the budget can be entered for comparison purposes.

**Note:** The sections "Versions" and "Budget Periods & Setup" are not required sections and can be viewed at any time. However, to edit these forms, none of the required forms (Budget Items, F & A, Cost Sharing, etc.) may be completed or "checked in".

**Note:** The example in the following pages is for a "Period by Period", modular budget, if you use a "Project" budget and/or a non-modular budget, there will be slight differences in the screens but the process is the same (see Appendix A for information on "Budget by Period" budget).
Budget > Budget Items to access Personnel and Non-Personnel Cost tabs.

Overview - This section allows you to enter specific budget information (personnel, non-personnel expenses, etc.).

Features

- In the Personnel Costs section the PI name/Role information is already available. Click folder icon next to the budget line item to open that line and make the proper adjustments.
- Add expense lines (Personnel and Non-Personnel Costs) by selecting [Click to add] in the appropriate budget section.
- The expense type “Subcontractors” is dependent on the answers given on the Setup Questions form. “Subcontractors” line item will not be available if the Setup Question (Step 8) is answered “No”.
- As budget items are added, a file folder icon will appear to the left of the line item. Click the file folder icon to view/update the corresponding budget line item.
Budget > Budget Items > Personnel Costs

Salary Information - Principal Investigator

Overview - This screen allows you to enter salary, benefits, and effort for the PI on the proposal. Budget information sheets for other individuals included on the proposal will have a similar format.

1. Salary/Payroll Information
   a. Select the appointment type: Calendar, Academic, or Summer and type in number of months.
   b. Type in Base Salary and select payment type: per appointment; per hour; per week
   c. Select Fringe Benefits type: None, Full-time federal; Full-time non-federal; or Part-time (amount will auto-populate)
   d. Select how the salary should be applied
      i. Continue Salary past Appointment end date – salary will continue to end of grant
      ii. Recycle Salary on the Annual Anniversary (respecting effective dates) – salary ends on the Appointment and date
   e. Select inflation type: Cost of Living 3% is standard for the University of Pennsylvania
   f. Leave the “Apply Inflation on the Primary Appointment Anniversary Date” unchecked – Penn does not use inflation adjustments based on appointment dates.

2. Project Responsibilities – Budget Justification information will be added as an uploaded work or PDF document.

3. Time and Effort Levels on Project – Remove 1 (which means 1% effort) and replace with the percentage of effort the staff member will be exerting on this project in each period

Note: For grants.gov proposals, Proposal Development will convert to Calendar Months

- Click Save icon when all effected periods are complete
- Click [Click to Add Next Person to the Proposal] to add additional staff to the proposal
Add additional Personnel

*Note:* Adding personnel to the budget will also add them to **Personnel** tab.

**Overview** - This screen allows you to add existing Penn personnel or new staff to the proposal.

### Add Existing Staff

**Features**
- Use the Alpha Split drop down menu to select the Penn staff/student name
- Select Position type of the staff/student from drop down box (faculty, fellow, student, etc.)
- Select the Personnel Type, i.e. role this person will perform on this proposal (Key Personnel, Non-Key Personnel, or Significant Contributor)
- Type in the amount of effort (where 1 = 1% effort) this person will contribute
- Verify the period information is correct and change if necessary
- Click [Select]
1. Add Appointment and Salary information, Fringe benefit type, Salary calculation type, and Inflation rate
2. Project Responsibilities – choose Personnel Type and Role on Project from drop down box selection (Budget Justification information will be added as a word/PDF uploaded document).

Effort information should be included from information typed on the previous screen but can be changed if necessary.

- Click Save icon

Add New Staff (non-contract personnel)

- Click [Click to Add Next Person to the Proposal]

Overview – This screen allows you to add new staff, not in the existing staff database, to the proposal (do not use for contractual personnel); usually staff that has not yet been hired, an unnamed staff member, or multiple students/graduate students.

Features
- Add staff that have not yet been identified
- Type “TBD” in the blank next to First Name
- Select the Position type (faculty, fellow, student, etc.)
- Complete the Effort information (where 1 = 1% effort)
- Click [Add]
1. Add Appointment and Salary information, Fringe benefit type, Salary calculation type, and Inflation rate.

2. Project Responsibilities – choose Personnel Type and Role on Project from drop down box selection (Budget Justification information will be added as an uploaded word or PDF document).

Effort information should be included from information typed on the previous screen but can be changed if necessary.

- Click Save icon

When all staff information has been added, click Budget Items to add non-personnel budget information.
Budget > Budget Items > Non-Personnel Costs

Overview - This screen allows you to enter non-personnel expenses such as travel, supplies, etc.

- Click [Click to add] to add Non-Personnel Costs

**Features**
- Description - type a descriptive label for the expense
- Budget/Charge Category – choose expense category type from drop down box list
- Annual Inflation – Cost of Living 3%
- Budget Justification – leave blank, information will be added as a word or PDF upload
- Purchase/Usage Schedule
  - Units/Quantity: 1 can be added in each period where there will be an annual expense
  - Price/Charge Each: Amount per period where there will be an annual expense
  - Multiple Units.Quantities with corresponding prices can be used if that is appropriate
- Click **Save** icon to view Budget Detail
Budget Detail

- Click [Click to add next item] to add next non-personnel budget item to create additional budget lines.
- When all budget items, Personnel and Non-Personnel have been added and saved, click Budget > Budget Items on the navigation menu path.

- To change Personnel Costs to a specific person:
  - Click the File Folder icon to the left of that line item.
  - Click on [Show Details] in the Salary/Payroll information section.
  - Click [Edit Section] and make appropriate changes.
- Click Save icon.
- Check "Completed" box on Budget Items form.
- Select Budget > F & A to view system calculated Facilities & Administrative costs.
Budget > Budget Items > Subcontractors

Overview – Addition of subcontractor information requires the selection of the subcontractor and the creation of the budget to be used by the subcontractor.

Features

- Select a subcontractor name and subcontractor PI NAME.
- Add budget detail for Personnel, Non-Personnel, and F&A costs.
- Provide cost-sharing information.
- Upload a budget justification.
- Differences between Penn budget information and Subcontractor budget information:
  - Fringe benefit amounts for salaries must be added manually.
  - F&A must be added manually.

- From the Budget Items screen, Select [Click to add] to add a subcontractor.
- Select the first letter of the subcontractor’s name from the alpha split-list and then find the specific organization from the drop down list.
- Note: If the subcontractor to be added to this project is not listed, please send an e-mail to PennERAhelp@lists.upenn.edu.
• Click [Select] to open the Subcontractor PI list.

Choose PI from existing names in the drop-down PI list (left) or add a new subcontract PI (below).

Once the PI has been selected or added, the Subcontracting organization is added to the budget items page.

• The system will return to the Budget > Budget Items page.
• Open the file folder that appears under “Detail Budgeting”
• Subcontract for Institution #XXXXXX is the University of Pennsylvania’s proposal number
• The Proposal number on this page is for the subcontracting institution
Add Personnel and Non-Personnel Costs for the Subcontractor using the steps described earlier in Budget > Budget items > Personnel Costs.

Add F&A information manually under each Period
- Click Edit icon for each budget period to open the F&A edit window.
- Enter Indirect Cost Type, Rate, and Base (Funds Requested will automatically calculate).
- Enter Sponsor Funds Requested and, if cost-sharing F&A, Inst Funds Requested.
- Click Save and Close.

When F&A entry has been completed, check “Completed” for subcontractor Budget Items tab.

Navigate to the subcontract Cost Sharing tab.
- Enter subcontractor cost-sharing information and check 'Completed' when finished.
- See Budget > Cost-Sharing for description of data entry.

Navigate to subcontract Budget Justification tab.
- Upload a budget justification if a narrative budget justification is required by the sponsor; check 'Completed'.
- Do not upload any justification if this is an NIH modular budget.

Click Done icon to close Subcontractor’s budget detail.
- Check "Completed" box to finish the Budget Items tab for the Penn budget.
- Navigate to Budget > F&A.
Budget > F & A (Facilities & Administrative Costs)

Overview – This screen shows the calculated Facilities & Administrative (F & A) expense on a line-by-line basis.

Features
- The negotiated F & A rates have been pre-defined in the application (see Setup Questions: Budget Setup Information Section)
- Calculation of F & A for Non-Personnel expenses is determined by the Category chosen
- Sponsor Calculation Method – select the desired method of calculation from the drop down box
- Scheme – defined in Setup Questions: Budget Setup Information Section
- Click Save icon
- Check “Completed” box
- Navigate to Budget > Cost Sharing

Note: Category selection of Non-Personnel expense items determines whether F&A will be calculated or not. Categories excluded from F&A include: Alternations & Renovations; Inpatient Costs and Outpatient costs; Participant – Stipends; Participant – Tuition; and Equipment (Purchased); Tuition (Research Projects), portion of each subcontract greater than $25,000 Total Costs, facility rental/user fees for offsite facilities.
Budget > Cost Sharing

Overview — This screen allows you to view, edit or enter Cost Sharing data for a project.

Features
- Funding sources include the sponsor, associated department (Inst and UnAllow), and subcontractor (UCLA in the above example).
- Additional cost sharing sources can be entered on an as-needed basis. [Add/Edit Sources] – opens box that allows for changes and additions to budget information.
- Cost sharing can be entered manually line-by-line. Account numbers (or other source information) should be added to the Account Number field when there is cost sharing.
- Check “Completed” box when finished.
- Navigate to Budget > Modular Budget (or Justification if this is not a modular budget).
Budget > Modular Budget

Overview – This screen summarizes the number of modules you are requesting when using the modular budget format.

Features
- Generally speaking, keep number of modules consistent unless equipment is being bought or some other large expense is occurring in one year vs. another year
- Modules are set up in $25,000 increments, usually with no more than 10 modules per year.
- Change or accept Direct Modules and/or F & A Basis Modules as necessary
- Click Save icon
- Check “Completed” box
- Select Budget > Justifications

Budget > Justifications

Overview - This screen allows you to upload a form or create and edit budget justifications for each budget item entered. Although manual data entry is possible, the PennERA Team recommends uploading a budget justification in the form of a Word or Adobe Acrobat document.

Features
- Upload Budget Justifications
- Select Upload Form radio button
- Click [Browse]
- Select word or PDF document
- Click upload icon
- Check “Completed” box
Budget > Budget Versions

Overview - This screen allows the user to save an existing budget as one version, then make changes and save as another version for comparison purposes.

- Select Budget > Versions if you would like to compare multiple budget possibilities in your proposal (this section does not need to be completed to “Finalize” the proposal).

Features

- Click “Download” icon to download saved budgets into Excel spreadsheets
- Click [Add New Version] to copy the initial version of the budget and create new ones
- Type a Version Name and Click [Save]

- Note new budget (Budget 2) is the “Active” budget
- Click File Folder icon make changes to the second version of the budget
- Click Save icon
- Check “Completed” box
- Remember this is not a mandatory form for completion of the proposal
Budget > Budget Periods and Setups

Overview – Summarization of Budget information entered for the proposal
- Select Budget > Budget Periods and Settings

Features
- This form allows changes to the budget period and setup as well as changing the PI.
- If any budget information (Budget Items, F & A, etc.) has been completed, no changes can be made to this form.
- To edit information on this page, no budget items may be marked as complete.
- Cost sharing can be entered manually on a line-by-line basis.
- Account numbers (or alternately other source information) should be added to the Account Number field when there is cost sharing.

Note: The funding source must be provided for all cost sharing, excepting over the NIH salary cap cost sharing.
Personnel (Upload Biosketch)

Overview — All Key Personnel require a CV to be added to the proposal. Enter budget information first and this screen will populate with Key and Non-Key Personnel information (and Other Significant Contributors for NIH proposals). Key Personnel are listed as PI first then in alpha order but the information can be “ordered” as you prefer. Current and Pending Support information can be added to the proposal.

Note: Follow sponsor instructions about uploading biosketches for Non-Key Personnel. In some instances, these may not be retrieved electronically by the sponsor upon submission. Determine which documents are mandatory, optional, or not required. “Not required” documents generally should NOT be uploaded.

Features

Name/Role Column
- Click personnel’s name link to open Contact information screen.
- Change or edit information as needed

Order Column
- Type in numeric order of key personnel.
- Click Save icon

Curr/Pend Support Column
- Click the checkbox in the Curr/Pend Support column to display “Get” icon
- Click [Browse] to select the Current/Pending Support document
- Click [Upload]

CV Required Column
- Click the checkbox in the CV Required column to display “Get” icon
- Click “Get” icon in CV Required column
- Click [Browse] to select the CV from pre-seated documents or select information from another/prior proposal
- Click [Upload]
- Use icon to remove PDF document

Remove Column
- Use icon to remove person from proposal

Complete Administrative Contact information.
Check “Completed” box.
PHS 398 Cover Page

Overview – Cover page for the proposal which includes information about the project and the University’s Organizational information.

- Select PHS 398 Cover Page

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains information from previously entered screens</td>
<td>Verify information – should be accurate based on Profile page</td>
</tr>
<tr>
<td>Add any additional information (Degree and County Information are required fields)</td>
<td>Click Save icon</td>
</tr>
<tr>
<td>Check “Completed” box</td>
<td></td>
</tr>
</tbody>
</table>

Features

- Contains information from previously entered screens
- Verify information – should be accurate based on Profile page
- Add any additional information (Degree and County Information are required fields)
- Click Save icon
- Check “Completed” box
PHS 398 Research Plan

Overview – This is the screen that requires you to upload the separate sections of the technical component of the research proposal.

- Select PHS 398 Research Plan

The application allows you to label the research plan as either draft version or final version. A research plan labeled as “draft” must be changed to “final” before it can be approved and submitted by ORS.

Features

- The type and number of forms to be uploaded is dependent on the answers on the Setup Questions form – review the form carefully to determine which documents need to be uploaded to the proposal.
- Upload each form following the upload steps previously described.
- As you upload each section, the Proposal Development application returns the document as a PDF, shows the page count for the upload, and the total page count for the Proposal.
- Follow the sponsor’s guidelines to ensure that basic required sections are uploaded. Additional documents may be required based on the use of human and/or vertebrate subjects, subcontractors, etc.
- Click Save icon
- Check “Completed” box

Note: To allow investigators as much time as possible, proposals may be submitted for internal review with Draft Version selected. However, Grants.Gov requires the proposal to be submitted with Final Version. The Office of Research Services is unable to submit a Draft Version to Grants.Gov. It is the responsibility of the Principal Investigator to submit a Final Version proposal in accordance with Penn’s internal submission deadlines to ensure the proposal is submitted in accordance with the sponsoring agency’s posted submission deadline.
PHS 398 Checklist

Overview — Information contained on this screen will be populated through administrative setups and information previously entered in the proposal.

Features

- Information is pre-populated from information contained in other forms on the proposal. Changes can be made if necessary to application type, investigator/institution information, etc.
- Click **Save** icon
- Check “**Completed**” box
PHS 398 Cover Letter

Overview – NIH offers the ability to upload a cover letter, separate from the application. This tab is only available if selected as an option on Setup Questions.

Features

- On Setup Questions, answer “yes” for the cover letter question.

- On this tab, click the Upload icon to add the cover letter.

- If the PI decides to NOT submit a cover letter:
  - Remove the cover letter from this tab FIRST.
  - Return to Setup Questions and change the answer to “no” for the cover letter question.

- Save.
- Check “Completed” box.
Internal Documents

Overview – This screen permits upload of internal documents for which there are no appropriate locations on the application tabs. It also contains the Proposal Transmittal and the PI Certification e-forms.

Features

- These locations are the same as found on the Finalize tab but permit the completion of the e-forms without having to build and assemble the proposal.

Important Note: The PI Certification and the Proposal Transmittal forms should not be completed until the proposal is ready for internal review and approval. This is a compliance issue in that the PI and the BA are attesting to the accuracy and completeness of the proposal information.

- Click on the Edit icon for each e-form. See the section “Finalize Proposal for Internal Review” for more details.
- Upload any internal documents required by your School or Department or by ORS or which would be helpful to the internal review process.
- Check “Completed” box

<table>
<thead>
<tr>
<th>Setup Questions</th>
<th>Internal Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF424 (R&amp;R)</td>
<td></td>
</tr>
<tr>
<td>Performance Sites</td>
<td></td>
</tr>
<tr>
<td>Other Project Info</td>
<td></td>
</tr>
<tr>
<td>Project Summary</td>
<td></td>
</tr>
<tr>
<td>Project Narrative</td>
<td></td>
</tr>
<tr>
<td>References Cited</td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td></td>
</tr>
<tr>
<td>Other Attachments</td>
<td></td>
</tr>
<tr>
<td>Personnel</td>
<td></td>
</tr>
<tr>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>PHS 398 Cover Page</td>
<td></td>
</tr>
<tr>
<td>PHS 398 Research Plan</td>
<td></td>
</tr>
<tr>
<td>PHS 398 Checklist</td>
<td></td>
</tr>
<tr>
<td>PHS 398 Cover Letter</td>
<td></td>
</tr>
<tr>
<td>Approvals</td>
<td></td>
</tr>
<tr>
<td>Finalize</td>
<td></td>
</tr>
</tbody>
</table>

Components for Initial Application

<table>
<thead>
<tr>
<th>Form Name</th>
<th>Document Type</th>
<th>Open Status</th>
<th>Action</th>
<th>Completed Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification by Principal Investigator</td>
<td>Certification</td>
<td>Incomplete</td>
<td>N/A</td>
<td>N/A (Mandatory)</td>
</tr>
<tr>
<td>Proposal Transmittal Form</td>
<td>Transmittal</td>
<td>Incomplete</td>
<td>N/A</td>
<td>N/A (Mandatory)</td>
</tr>
</tbody>
</table>

Add Institution Forms/Supporting Documents

Completed ☐
Approvals

Overview – Section to upload specific approvals for protocols such as human subjects or lab animals

- Click [Add] to open Add/Edit Approvals box
- Click [Continue]
- From the drop down box select the status of the protocol
- Complete other known information
- Click Save icon.

- Check “Completed” box
Finalize a Proposal for Internal Review

Section Overview - Once you have completed your proposal and all screens are complete, you are ready to begin the Submit process. This process is contained within the menu option called “Finalize”.

Finalize Proposal for Internal Review

- Build and Assemble
- Review prior to Submission
- Submit for Routing and Approval
- Review Progress through Approval Process

Although Proposals can be routed for review and approval if the Research Plan is in “draft” form, all Research Plans should be changed from “Draft Version” to “Final Version” before submission to ORS.

Note: To allow investigators as much time as possible, the research plan of the proposal may be submitted for internal review with Draft Version selected. However, grants.gov requires the research plan of the proposal to be submitted in Final Version. The Office of Research Services is unable to submit a Draft Version to grants.gov. It is the responsibility of the Principal Investigator to submit a Final Version proposal in accordance with Penn’s internal submission deadlines to ensure the proposal is submitted in accordance with the sponsoring agency’s posted submission deadline.
Build Proposal and Assemble Application

Overview – This is the first step in the Submit process. This section builds a PDF document from all completed sections. Should any section be changed after this build, then the proposal will have to be re-built.

Features

- Click **Finalize** menu item
- Click **[Build]** to convert your proposal into a PDF format.

- Click **[Build Grants.gov Application]** to create the application package.
- Generic forms require you to place your forms in order.
Submit for Internal Review

**Overview** – From this page the proposal is finalized prior to internal routing and approval. If the *PI Certification* and *Proposal Transmittal* forms were not completed on the Internal Documents tab, they should be completed here. The *Certification by the PI* and *Proposal Transmittal Form* must be completed before the proposal can be submitted for internal approval.

**Build PDF / Form Pages**

Assemble Application

**Submit for Internal Review**

Once your proposal has been completed, it can be electronically routed internally for necessary approvals. This page will display in two modes: Unsubmitted and Submitted. The screen is in unsubmitted mode when your proposal has not yet been routed. You can determine this by visually identifying a “thumbs up” on the screen. If it is there, then the proposal has not yet been submitted.

The screen is in submitted mode when your proposal has been submitted and you can see the approval path it is on. Your Administrator has configured the approval path that they feel is appropriate for your proposal. If you have any questions regarding this process, please contact them.

**Features**

- Completion of documents for the final routing through University approvals paths to ORS to the funding authority
- Click the “Open” icon to complete the Certification by PI form (see section)
- Click the “Open” icon to complete the Proposal Transmittal form (see section)
- Select the eyeglass icon under “Completed Forms” to view a PDF version of the forms.
- Click the link labeled *Add Institution Forms/Supporting Documents* to attach documents that will not be sent to the sponsor, but are required by the University.
- If you have other forms that you want to go to the Sponsor, use “Other Attachments”
- When all forms have been completed click the icon to submit the proposal:
  - The PI or another authorized person, usually the BA, can complete this step.
  - Click [Submit]
  - Approval routing path pop-up box appears. Add New Person to Review Path or click [Submit] to send proposal to reviewer/approver.
Certification by Principal Investigator

Overview – This e-form is an internal Penn form and is to be completed by the PI; questions should not be pre-answered by other users.

- Click Open icon beside Certification by Principal Investigator
- The form will open in Edit mode.
- Answer questions by clicking appropriate boxes
- Check "Complete" box which will save, lock the form, and close the browser window.
- The form may be manually accessed, saved, and locked by mousing over the Menu tab at the top left side of the form.
Proposal Transmittal Form

Overview – This screen is an internal Penn e-form. Information must be entered for required questions, identified with an *, as well as the Departmental Administrative contact, Future Account Segment Information, and Facilities to be used (enter as Building name, Floor #, and Room #). It is optional to enter contact information for the Sponsoring Agency/Granting Organization.

- Click Open icon beside Certification by Principal Investigator
- The form will open in Edit mode.
- Answer questions by clicking appropriate boxes
- Check "Complete" box which will save, lock the form, and close the browser window.
- The form may be manually accessed, saved, and locked by mousing over the Menu tab at the top left side of the form.
Submit for Routing and Approval

Overview – This screen allows the PI or other designated person to route the proposal for internal approval.

Features

- Click on the [Submit Final Review] icon to begin the routing process.
- A certification will be displayed.

Certification

I certify that I have permission of the Principal Investigator to submit this proposal on their behalf for Review and Approval, and that the Principal Investigator has completed the PI Certification eForm. I understand that any false,

☐ Accepted ☐ Declined

[Continue]

- Read, select ‘Accepted’, if appropriate, and click [Continue].
- Click the link Add New Person to Review Path to add Approvers or Reviewers before “Step 1” or click [Submit]
- Select the insert icon next to an individual in the routing path to insert an Approver or Reviewer after that particular step.

People added to a route can be an Approver or a Reviewer. To make someone a Reviewer, select the radio button, "Information only" when adding them to a route. To make someone an Approver, select the radio button, "Approval Required" when adding them to a route.

- Choose name from drop down box
- Click [Select]
- Click [Submit] to send the proposal into the approval queue

Routing Progress

<table>
<thead>
<tr>
<th>Step Number</th>
<th>Step Name</th>
<th>Who</th>
<th>Notified</th>
<th>Completed</th>
<th>Decision Insert</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Trainer</td>
<td>JAMES I HORTMANN</td>
<td>07 Jan 2007 5:23:05 PM</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

No comments have been recorded yet
Status of Approval Process

Overview – Once the proposal has been submitted for internal routing, the user may return to the Finalize screen to determine the progress of the proposal through the routing path.

- Each person on the approval route will receive an email and a PennERA message to alert them to your proposal
- Click save and Done icon when completed and to exit the proposal process
Review, Approve or Reject a Proposal

Section Overview - When someone is defined as an Approver for a particular proposal, he/she must either approve or not approve the proposal. Upon approval, the proposal routes to the next defined step in the path. Upon rejection, an email and PennERA message is sent to the PI who originally sent the proposal.

- Reviewers receive a copy of the Proposal for informational purposes only.
- Approvers receive a copy of the Proposal and act upon the Proposal to either approve or reject the Proposal. The Proposal cannot progress to the next step in the routing process unless the approver acts upon the Proposal.
- The Approver can insert additional people into the routing path.
- Approvers can also see who has already seen/approved the Proposal and who is next in the routing path.
- Approvers can add comments as part of the review process. Comments can be shared (optionally) with only the Investigator, only Administrators, only approvers, or everyone.
Message Received by Approver/Reviewer

Overview – When a proposal is routed for approval or review, the recipient receives both an external (University) email and internal (within PennERA) message

Features

1. A Reviewer will receive a link to a copy of the proposal.
2. An Approver receives both the link to a copy of the proposal and a link that will direct him/her to the Review Dashboard.

External Email –

1. Click on to open the Review Dashboard under ‘My Open Action Items’.
2. Previously reviewed and completed items may be viewed by clicking on ‘Completed’ under ‘My Action Items’.

The reviewer may also access the Review Dashboard through the internal PennERA notification system at My Messages.

- Click on Inbox to access a list of messages.
- Click on the envelope icon to view the message.
- Access the Review Dashboard from the message (see example on next page).
From: Mr. Svawely, Todd S
To: Ford, Evelyn J - 8760 - Research Services
Subject: Approval Needed - 10023443 - 8760 - Research Services

Proposal 10023443 submitted by ORG 8760 - Research Services for STEPHEN FRATANTARO from 8760 - Research Services requires your approval. Your prompt attention to this request is appreciated. If you have any concerns about the proposal, please contact your departmental administrator.

To review, approve or disapprove this proposal click: Reviewer Dashboard

Attachments:

Open Reviewer Dashboard to enter decision (if an approver)

Open Proposal (security rules determine who can access)
Review Dashboard

Overview – This Review Dashboard allows a reviewer to approve or reject a proposal, view and add comments, and track the proposal's progress through the internal review process.

Features

- Click any one of tabs on the left to view information or actions available on that tab.
- "HELP" provides instructions for completing the review process and department contact information for any questions.
- "REVIEW" displays the items to be reviewed, provides an area for comments, shows comments of previous reviewers, and records the reviewer’s decision.
- "ROUTE" shows the routing progress and provides the option to insert additional approvers or informational only reviewers.

Review Dashboard > HELP

Overview – This screen provides an explanation of each tab in the Review Dashboard, instructions for completing the proposal review, and department contact information for this routing path if there are any questions.
Review Dashboard > REVIEW

Overview — By clicking the “REVIEW” tab, approvers can see items they must act on, view and add comments, and record their decision.

![Review Dashboard Table]

**Reviewer Action**

All items may be accessed by clicking on the icon in the “View” column.

1. Open the record in Proposal Development by selecting the view icon for “Proposal”, which is always the item listed first.
   - When you’re finished reviewing, click the **Done** icon to properly exit the Proposal record.
2. A PDF facsimile of the entire proposal can be viewed by opening the Assembled Doc, the second item listed.
3. Each of the e-forms (Certification by Principal Investigator, Proposal Transmittal Form, and SOM Research Categorization) can be accessed for review.
   - Close the browser window when you’re finished reviewing the form.
   - Do not uncheck the ‘Complete’ box unless you have authorization to edit the form.

After reviewing an item, select “Reviewed” in the “Reviewer Action” column for that item. Select “Not Applicable” if an item is not relevant to your review and is not reviewed.
Click the **Save** icon in the upper right corner to save the review selections.

**Add Comments**

**Overview** – This section allows the user to add comments.

**Features**
- The Reviewer has the option of adding comments that everyone can see, only the PI can see, only Reviewers see, or only Administrators can see.

**Note:** Comments added by earlier reviewers may be viewed on this screen in the upper right portion of the window.
My Decision

Overview – This section allows the reviewer to approve or disapprove the proposal.

Features
- Scroll to the bottom of the “Review” tab to locate this section.
- Select Approved or Not Approved from the drop-down list.
- Click the Save icon in the upper right corner to save the decision.
- Once the decision has been selected, the Approver may be prompted to re-authenticate – type PennKey ID and password.

Click the in the upper right corner to close the Review Dashboard when finished.

Review Dashboard > ROUTE

Overview – By clicking the “ROUTE” tab, reviewers can see the progress of a proposal in the routing path and also add other approvers or informational-only reviewers.

Features
- View routing progress:
  - Date/timestamp in “Notified” column identifies the time at which each person was notified to review the proposal.
  - Mouseover “Approved” in the “Decision” column to view the approved timestamp.
- Click on the insert icon to add approvers or informational-only reviewers.
Submit to Sponsor

Section Overview – Once ORS submits the Proposal to the Sponsor, the Sponsor may accept the Proposal or return it for modification, or reject it completely.

ORS submits the Proposal either electronically (for those Sponsors who support electronic submission) or, if the Proposal is to be submitted via hard copy, the PI prints the Proposal and submits it to the Sponsor. In this case, ORS will print the “signature page”, sign it and return it to the PI (usually via the administrative contact).

ORS is the conduit for submission to the Sponsor and usually for Proposals returned by the Sponsor for modification. Questions or concerns about a returned Proposal should be handled through ORS.

Electronic Submission to Sponsor (i.e., Grants.Gov)

Overview – Check the “Finalize” screen to determine the Grants.Gov ID#, status, etc.

Features
• If the Sponsor detects a problem with the Proposal, it is returned via ORS for edit/correction.
Submit Other/Paper

Overview – Click the icon to view and print a PDF document if needed for paper records or submission to the Sponsor.

Features

- A user can print a copy of their proposal by accessing the proposal through Proposal Development, and selecting “Finalize” from the left-hand navigation menu. Then, select the icon under the heading “Completed Form” to view a PDF version of the proposal. At this point, the user may print out the PDF document or save it to his/her computer.
Appendix A

How do I... change the PI?

The default PI on a proposal is the person who originally creates the proposal. This information can be changed in several locations.

A. New Proposal Questionnaire
   - Select Proposals > [Create Proposal]
   - Click [Change PI]

   1. New Proposal Questionnaire
      - This Proposal will be created with GORMAN, JOANNE M as the PI.
      - Change PI

      Step 1
      - Create a "New" Proposal or "Copy From Existing"?
      - Do you want to...
        - Create a New Proposal
        - Copy From Existing Proposal

      - Select personnel information from alpha drop down box or search for a particular party or filter by position (make sure ORG information is correct).

      - Click [Select].

      - Complete the proposal creation process.
      - Associated Department will be that of the new PI.
      - Approval routing will be based on the new PI's approval routing path.
B. Budget > Budget Periods and Setups

- In the “Change PI” section click [Change].

- From the drop down box select Replace PI and Leave the Current PI on the Proposal or Replace and Remove the Current PI.
- Choose the new PI from the alpha drop down box and click [Select].

Note: Budget information for the new PI will have to be added to the proposal. If the original PI was not removed in the above step, s/he can be removed later.

Other forms that may need to be changed, if the PI is changed, are:
- Personnel – upload new CV/biosketch
- Performance Sites
- Resources, especially Facilities
- Budget > Budget Items – effort, salary; other budget tabs as necessary
- PHS 398 Cover – degrees
How do I... add or change default Associated Department?

Department and Center information defaults to the PI's information, but often multiple Departments or Centers will work together on a proposal.

- On the "Setup Questions" page in the "General Proposal Properties" section of the questionnaire, click Add in the Associated Departments row

- Use the Numeric drop down box to locate the department name.
  - Highlight the ORG Number – Department Name.
  - Click [Select].

- Click the appropriate radio button beside the Primary Department.
  - Primary ("Prime") department = routing path for approval of proposal.
  - Note: At Penn, this is also known as the "Responsible Org".

- Add any Departments for which a subaccount will be issued if the project is funded.
- Remove any Departments that will not have a subaccount issued if the project is funded.
  - Informational copies of the Proposal can be provided during routing and approval for participation departments for which a subaccount will not be issued.
How do I create a simplified budget?

A simplified budget may be created for any generic record and for modular budgets in an S2S record.

**NOTE:** The example is for an S2S modular budget, but the same type of budget entry is applicable to any generic record.

**Budget**
- Click on **Budget > Budget Items.**

  ![Budget Items](image)

- **Personnel Costs**
  - **Click to add**

<table>
<thead>
<tr>
<th>Open Name / Title</th>
<th>Type</th>
<th>Effort</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRATANTARO, STEPHEN N/A</td>
<td>Key</td>
<td>1.00</td>
</tr>
</tbody>
</table>

  **Total** $0.00 $0.00 $0.00

- **Non-Personnel Costs**
  - **Click to add**

  **Final** $0.00 $0.00 $0.00

- Add all Key Personnel included with the proposal.
  - Select **Click to Add** and find the individuals you wish to add from the alpha-split list.
  - Define role on the project and update Key Personnel effort.
  - Click on **Save** then **Back** to return to **Budget Items.**
- Enter your total direct expenses by adding one non-personnel expense line.

- Select [Click to add] from the Non-Personnel Costs section.

- Enter a description of the direct expense.
- Select Budget/Charge category “Other Costs *”.
- Enter the expense amount for each year.
- Click Save to perform calculation.
- Click Budget Items.
Check the “Completed” box for Budget Items.

Select the F & A form.
Check the “Completed” box (assuming you agree with the system calculation).

Facilities and Administration Costs

Non-Personnel Costs

Completed

Completed

Completed
Cost Sharing

- Click the Cost Sharing form.
- Check the "Completed" box (assuming you agree with the system calculation).
Modular Budget

- Click Modular Budget tab.
- Select the number of modules you are requesting for each budget period from the drop-down box located in the middle of each “block” and click Save.
  - It’s imperative you click Save before you complete the modular budget page.

- Check the “Completed” box for the modular budget page.

Justifications

- Select Justifications tab.
- Enter or Upload your budget justification including Subcontractor Justification if applicable.
  - Note: “Upload Form” is the recommended method.
• Check the “Completed” box.
How do I... budget for F&A exemption expenses like equipment in a simplified budget?

**Solution:** While you could create a budget containing only one line for total direct costs and adjust the F&A manually, we recommend you create separate line items for these types of expenses. The application will NOT calculate F&A on budget categories exempted from F&A, such as Purchased Equipment. If you use the correct categories in your budget, you won’t have to remember to adjust the F&A manually.

Example: This proposal includes expenses totaling $125,000 and $150,000 in years 1 and 2, respectively. In this example, $15,000 is budgeted for equipment in the first year only. Your budget would look like this:

Once you complete this section, go to the F & A page. Note the F&A base reflects the total less the equipment exemption.
expense (Exemptions, $15,000) to determine the Base ($135,000) for the F&A $.

Always click Save, before you complete the Modular Budget page.
How do I... enter genomic array (microarray) expense?

Genomic array (GA) expense incurred with an external vendor requires specialized data entry as outlined in NIH Notice NOT-OD-10-097, issued May 2010 (http://grants.nih.gov/grants/guide/notice-files/NOT-OD-10-097.html). This is a requirement for NIH proposals only, modular budget proposals and those requiring the 424 detail budget forms.

Note: Microarrays obtained from internal resources/service centers should continue to be treated as supply expense with full F&A recovery.

If the annual cost does not exceed $50,000/year for each external source, these special steps are not required. The expense should be budgeted as supply costs.

If the expense exceeds $50,000 in any year, then follow the steps outlined below. Use for any record type (S2S or generic template), and all budget entry methods: modular, simplified, detail.

Only the cost of the arrays should be included: No staff time or other associated sequencing costs should be included in this calculation methodology.

Setup Questions tab

• General Proposal Properties -- Answer “yes” to subcontractor question.

Budget tabs

Budget Items tab:

• Create a new expense line in the Non-Personnel Expense section.
  ▪ Description – “Genomic Arrays to annual limit ($50,000)”
  ▪ Budget Category – “Other Costs”
  ▪ Enter annual GA costs, not to exceed a maximum of $50,000/year.

• Create a new subcontractor entry.
  ▪ Choose “GENOMIC ARRAYS - EXTERNAL” as the subcontractor name.
  ▪ Choose “Arrays, Genomic” as the PI.
  ▪ Enter subcontract PI expense line and make the following adjustments:
    ▪ ‘Role of Project = Other (Describe), enter “Genomic Arrays’
    ▪ Effort = 0.10 in any year that has expense
  ▪ Create a Non-Personnel Expense entry.
    ▪ Description – “Excess of GA expense over $50,000”
    ▪ Budget Category – “Other Costs”
    ▪ Enter amount that exceeds $50,000 in any year.
    ▪ DO NOT ENTER ANY VALUES IN THE F&A LINE.
    ▪ If any year = $0, mark the year “Inactive”.

F&A tab:

• Choose Sponsor Calculation Method – Manual (line by line).
• Edit the GENOMIC ARRAYS subcontract information:
  ▪ ‘Sponsors F&A Base’ IN EVERY YEAR should = ‘Sponsors Directs’ expense line or $25,000, whichever is the lesser amount.
  ▪ Calculate and enter ‘Requested F&A’ based on ‘Sponsors F&A Base’.
**Cost Sharing** tab:

- Move any costs on 'Indirect Costs' line from 'Inst' to 'UnAllow'.

**Modular Budget** tab:

- Save the tab after the screen has opened *even though there has been no editing yet.*
- Adjust the number of modules in each year, if necessary; Save.
- Check modular budget calculation chart to ensure that all values are correct.

**Justifications** tab:

- Prepare the type of justification required for the proposal.
- Include this explanation of the subcontract for the GA expense:

  **Budget Justification for Genomic Arrays**

  In accordance with NIH Notice OD-10-097 (Budgeting for Genomic Arrays for NIH Grants, Cooperative Agreements and Contracts), a subcontract has been created for the Genomic Array expense that exceeds $50,000 in any given budget period of this proposed project. This is an S2S submission which requires listing a PI for this 'subcontract' with a small amount of (unfunded) effort to avoid validation errors.

  Genomic array expense up to $50,000/year has been included in the University’s portion of the project budget under the cost category Supplies.

  Questions regarding this methodology should be directed to the Signatory Official.

- If this is a modular budget justification, upload to the "Consortium Justification” location.
- If a 424 detail budget justification is prepared, include this paragraph with the Penn justification.

**[Screen shots of the budget entry appear on the next two pages.]**

**Personnel** tab:

- Upload a “biosketch” for the “PI” of the GA subcontract.
- Do not use a formatted biosketch or NIH biosketch form; create a standard Word document with the following text:

  This is a biosketch upload for the “PI” location of the subcontract created in a system-to-system proposal record to accommodate the necessary calculations for genomic arrays per Notice NOT-OD-10-097 (Budgeting for Genomic Arrays for NIH Grants, Cooperative Agreements, and Contracts), requiring treatment of a certain portion of the genomic array expense as a subcontract.

**Performance Sites** tab:

- Make the following entries for the GA "site":
  - Enter zeroes for the DUNS number (00-000-0000).
  - Enter PA-002 for the Congressional District.
  - Enter external vendor’s information for the address.
### Penn Budget Items tab

**Budget Items**

#### "Initial" Budget Version

<table>
<thead>
<tr>
<th>Personnel Costs</th>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Name / Role</td>
<td>Type</td>
<td>Effort</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ford, Erin / INJE</td>
<td>Key</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**Total** $0.00 $0.00 $0.00 $0.00 $0.00 $0.00

<table>
<thead>
<tr>
<th>Non-Personnel Costs</th>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Budget Category</td>
<td>Item</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplies</td>
<td>Genomic Arrays to annual cap ($250K)</td>
<td>$50,000.00</td>
<td>$50,000.00</td>
<td>$50,000.00</td>
<td>$0.00</td>
<td>$150,000.00</td>
<td></td>
</tr>
</tbody>
</table>

**Total** $50,000.00 $50,000.00 $50,000.00 $0.00 $0.00 $150,000.00

<table>
<thead>
<tr>
<th>Subcontractors</th>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Short Form</td>
<td>Inst/Contractor Name</td>
<td>Detail Budgeting</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Genomic Arrays</td>
<td>GENOMIC ARRAYS - EXTERNAL</td>
<td>$25,000.00</td>
<td>$100,000.00</td>
<td>$100,000.00</td>
<td>$0.00</td>
<td>$225,000.00</td>
<td></td>
</tr>
</tbody>
</table>

**Total** $25,000.00 $100,000.00 $100,000.00 $0.00 $0.00 $225,000.00

**Final** $25,000.00 $150,000.00 $150,000.00 $0.00 $0.00 $375,000.00

### Genomic Arrays 'subcontract' Budget Items tab

**Subcontract for Institution # 10029860**

**Arrays Genomic - GENOMIC ARRAYS - EXTERNAL (NATIONAL INSTITUTES OF HEALTH)**

**Proposal**

10029860

**Budget Items**

#### "Initial" Budget Version

<table>
<thead>
<tr>
<th>Personnel Costs</th>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Name / Role</td>
<td>Type</td>
<td>Effort</td>
<td>Inactive</td>
<td>Inactive</td>
<td>Inactive</td>
<td>Inactive</td>
</tr>
<tr>
<td>Genomic Arrays</td>
<td>Key</td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**Total** $0.00 $0.00 $0.00 $0.00 $0.00 $0.00

<table>
<thead>
<tr>
<th>Non-Personnel Costs</th>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Budget Category</td>
<td>Item</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplies</td>
<td>Excess of 66s over 56,000</td>
<td>$25,000.00</td>
<td>$100,000.00</td>
<td>$100,000.00</td>
<td>$0.00</td>
<td>$225,000.00</td>
<td></td>
</tr>
</tbody>
</table>

**Total** $25,000.00 $100,000.00 $100,000.00 $0.00 $0.00 $225,000.00

**Final** $25,000.00 $100,000.00 $100,000.00 $0.00 $0.00 $225,000.00

**F&A**

<p>| | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
</table>

**Totals** $25,000.00 $100,000.00 $100,000.00 $0.00 $0.00 $225,000.00
## F&A tab

### Facilities and Administration Costs

<table>
<thead>
<tr>
<th>Institution Base/Target Scheme</th>
<th>Research On-Campus Scheme</th>
<th>Show</th>
<th>$105,000.00</th>
<th>$135,000.00</th>
<th>Drift</th>
<th>$(30,000.00)</th>
</tr>
</thead>
</table>

### Personnel Costs

<table>
<thead>
<tr>
<th>Period</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ford, Evelyn</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sponsors Directs</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Sponsors F&amp;A Base</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Requested F&amp;A</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Directs &amp; F&amp;A Total</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

### Non-Personnel Costs

<table>
<thead>
<tr>
<th>Supplies</th>
<th>Period</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sponsors Directs</td>
<td>150,000.00</td>
<td>150,000.00</td>
<td>150,000.00</td>
<td></td>
<td></td>
<td>$450,000.00</td>
<td></td>
</tr>
<tr>
<td>Sponsors F&amp;A Base</td>
<td>150,000.00</td>
<td>150,000.00</td>
<td>150,000.00</td>
<td></td>
<td></td>
<td>$450,000.00</td>
<td></td>
</tr>
<tr>
<td>Requested F&amp;A</td>
<td>90,000.00</td>
<td>90,000.00</td>
<td>90,000.00</td>
<td></td>
<td></td>
<td>$270,000.00</td>
<td></td>
</tr>
<tr>
<td>Directs &amp; F&amp;A Total</td>
<td>$240,000.00</td>
<td>$240,000.00</td>
<td>$240,000.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$720,000.00</td>
<td></td>
</tr>
</tbody>
</table>

### Subcontractors

<table>
<thead>
<tr>
<th>GENOMIC ARRAYS - EXTERNAL (NATIONAL INSTITUTES OF HEALTH)</th>
<th>Period</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sponsors Directs</td>
<td>225,000.00</td>
<td>225,000.00</td>
<td>225,000.00</td>
<td></td>
<td></td>
<td>$675,000.00</td>
<td></td>
</tr>
<tr>
<td>Sponsors F&amp;A Base</td>
<td>75,000.00</td>
<td>75,000.00</td>
<td>75,000.00</td>
<td></td>
<td></td>
<td>$225,000.00</td>
<td></td>
</tr>
<tr>
<td>Requested F&amp;A</td>
<td>45,000.00</td>
<td>45,000.00</td>
<td>45,000.00</td>
<td></td>
<td></td>
<td>$135,000.00</td>
<td></td>
</tr>
<tr>
<td>Directs &amp; F&amp;A Total</td>
<td>$340,000.00</td>
<td>$340,000.00</td>
<td>$340,000.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$1,020,000.00</td>
<td></td>
</tr>
</tbody>
</table>

### Cost Totals

| Direct Cost Totals | $75,000.00 | $150,000.00 | $150,000.00 | $0.00 | $0.00 | $375,000.00 |
| F&A Base Totals | $75,000.00 | $75,000.00 | $75,000.00 | $0.00 | $0.00 | $225,000.00 |
| F&A Totals | $45,000.00 | $45,000.00 | $45,000.00 | $0.00 | $0.00 | $135,000.00 |
| Grand Totals | $120,000.00 | $195,000.00 | $195,000.00 | $0.00 | $0.00 | $510,000.00 |
How do I... resize scanned documents or odd-sized PDFs?

Grants.gov and other electronic submission systems required uploaded documents to be 8½x11 inches. Most scanned documents will not be exactly that measurement, so they will need to be resized before they can be uploaded into Proposal Development.

If an uploaded document is not the correct size, an error message will appear when an upload is attempted.

*Note*: Adobe Acrobat Professional is required to resize PDF documents.

1. **Determine the page size**

   - Open the scanned document in Acrobat Pro.
   - Select **Properties** from the File menu.
   - Check the **Page Size**.

   *Note*: PDF documents created by combining scanned and converted pages will have some pages that are correctly sized. Any page may be checked by first going to that page, then checking page size.
2. **Change the Page Size**

- Open the *Print* dialog box from the *File* menu.
- Choose *Adobe PDF* as the printer.
- Remove the checkmarks, if present, from *Print to file* and *Choose Paper Source*: The document measurements should change to 8.5 x 11.
- Click [OK] to print.

3. **Check the new PDF**

- Close the original document and open the new one.
- Check *Properties* to verify the *Page Size*.
How do I... change project/budget period dates or add or remove budget periods?

It may be necessary for the project period start and/or end dates to be shifted when an existing proposal is copied, if a typographical error is made when entering the project period dates in the proposal creation questions, or if the PI changes the anticipated start date after the proposal has been created. For similar reasons, the number of Budget Periods may also need to be increased or decreased.

- From Navigation menu, select [Budget], then select [Budget Periods and Setups].

**Shifting the start and end dates of the project**

**NOTE:** Use the “Project Period” section only to change (shift) the start and end dates of the project if the number of budget periods is already correct. Do not use the “Budget Period” section to change the dates unless instructed by end-user support staff to edit dates there.

- Click **Shift** next to “Project Period” to display **Shift Project Dates**.
Determine the best option to modify the dates:

**Note:** If you need to add or remove Budget Periods, complete that step first. See the next section for instructions on that process.

1. **“Shift by”**
   - This is the best and most reliable option to use, especially if some budget data has already been entered.
   - Both the start and end dates are shifted forward or backward by the number of days, weeks, or months designated by the user.

2. **“Project Start” and “Project End”**
   - Use this option when the start and end dates need to be changed by different amounts.
   - The user enters the new dates. The start and end dates of each period will be adjusted according to the new information.

**Option 1: “Shift by”**

Enter the amount then choose days, weeks, or months.

To move the dates backward, enter negative values, e.g. “-1” month.

Click **Save**. 

**WAIT** while the new project period is calculated and [Shift Project Dates] screen is closed.

**WAIT** while [Budget Periods and Setups] is refreshed and new dates are displayed.

**Option 1 Dates for each budget period have been reset.**

Start and End Dates for Project Period have been reset.
Option 2: Specify new “Project Start” and “Project End”

- Enter the new start and end dates.
- Both a start and an end date must be entered, even if one of those dates is not changing.
- Click [Save].
- **WAIT** while the new project period is calculated and [Shift Project Dates] screen is closed.
- **WAIT** while [Budget Periods and Setups] is refreshed and new dates are displayed.

Adding or deleting Budget Periods

- Next to “Budget Period”, click **Add** or **Remove**.
- **OK** to continue.
- **WAIT** while [Budget Periods and Setups] is refreshed and the changed number of periods is displayed.
One budget period removed.

Advanced Budgeting allows the user to move between the Budget Detail, F&A, and Cost Sharing pages in any order. By doing so you may be overwriting system default calculations.

Track Un-Allowable Charges in a separate "Source" for budgeting purposes. This will identify "un-allowable" charges/Costs as determined by sponsor rules and hold them in a separate "Budgeting Source" box.

Show Budget Summary on the budget detail. This can be useful when doing Cost Sharing and F&A budgeting.
How do I... view the cumulative budget totals?

- Choose **Budget > Budget Periods and Setups**
  - Check **Show Budget Summary**
  - ![Save]

---

### Budget Periods and Setups

<table>
<thead>
<tr>
<th>Project Period</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>01-Apr-2009</td>
<td>31-Mar-2014</td>
</tr>
</tbody>
</table>

- **Choose Budget > Budget Items**
  - Choose any budget line item: This example uses one of the personnel entries.
  - Click on the ![icon] to open the detail screen for that item.

- Under **Budget Summary Section**, click in each of the checkboxes to view the accumulating costs for this proposal.
  - **Project** – Total project costs.
  - **NATIONAL I...** – The second group of costs is always the sponsor’s total costs.
  - **4521 – PA-...** – The third group of costs is institutional, formal cost-sharing. This cost-sharing will be included on the SF424(R&R) face page.
  - **4521 – PA-...** – The final group of costs is unallowable expense. Usually the only expense in this category is the amount of salary (and associated fringe benefits) for personnel whose annual salary exceeds the NIH cap. This is not formal cost-sharing, but is expense not supported by the sponsor. It will not be included on the SF424(R&R) face page.
See Screenshot of expanded Budget Summary Section on the following page.
**Budget Summary Section** (*check the boxes below to view their corresponding budget summary sections*)

<table>
<thead>
<tr>
<th>Project</th>
<th>4521 - PA-...</th>
<th>4521 - PA-...</th>
</tr>
</thead>
</table>

### Project Budget Summary

<table>
<thead>
<tr>
<th>Period</th>
<th>Direct Costs</th>
<th>Indirects</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$40,172.95</td>
<td>$20,099.29</td>
<td>$60,272.22</td>
</tr>
<tr>
<td>2</td>
<td>41,378.03</td>
<td>23,792.37</td>
<td>65,170.40</td>
</tr>
<tr>
<td>3</td>
<td>42,619.37</td>
<td>24,906.14</td>
<td>67,525.51</td>
</tr>
<tr>
<td>4</td>
<td>43,897.95</td>
<td>25,241.82</td>
<td>69,139.78</td>
</tr>
<tr>
<td>5</td>
<td>45,214.09</td>
<td>25,990.56</td>
<td>71,204.65</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$213,281.80</td>
<td>$122,837.78</td>
<td>$336,119.58</td>
</tr>
</tbody>
</table>

### NATIONAL INSTITUTES OF HEALTH Budget Summary

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>$40,172.95</td>
<td>$41,378.03</td>
<td>$42,619.37</td>
<td>$43,897.95</td>
<td>$45,214.09</td>
<td>$213,281.80</td>
</tr>
<tr>
<td>Indirect Costs</td>
<td>23,792.37</td>
<td>24,906.14</td>
<td>25,241.82</td>
<td>25,990.56</td>
<td>336,119.58</td>
<td>$336,119.58</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$63,965.32</td>
<td>$66,284.17</td>
<td>$67,861.19</td>
<td>$69,139.78</td>
<td>$71,204.65</td>
<td>$336,119.58</td>
</tr>
</tbody>
</table>

### 4521 - PA-Pathology & Laboratory Medicine Budget Summary

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>$0.00</td>
</tr>
<tr>
<td>Indirect Costs</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>$0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

### 4521 - PA-Pathology & Laboratory Medicine Budget Summary (Sponsor Non-Allowable Costs/Charges)

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Period 5</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>$0.00</td>
</tr>
<tr>
<td>Indirect Costs</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>$0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**Note:** Because the values are constantly updated as the budget is developed, the expanded sections are not automatically open on each budget detail screen view. Just re-check the boxes to view the budget details.
How do I... budget for Academic and/or Summer appointments?

Providing the necessary data in PennERA Proposal Development for faculty with academic/summer appointments is only required when a 424 R&R detail budget must be submitted to Grants.Gov. In all other instances, it is not mandatory to provide this information in PD unless the School or Department wishes to have this information entered.

Simple entry of summer/academic appointment information

When a spreadsheet with the budget detail has already been developed, a simplified method of data entry can be used to provide the information in PD for the 424 R&R detail budget information.

424 detail forms only require person months for academic and summer or calendar appointees. Salary and benefit information does not need to be provided by these classifications.

1. Setup Questions

- Choose either “Budget Period by Period” or “Budget by Total Project” budgeting model.

2. Create personnel detail based on 12-month (annualized) salary.

   - Determine annualized salary: Monthly salary x 12 months.
   - Be sure to consider any salary changes that may occur during the first budget period.
   - Determine annualized effort: Totals months' effort for first year / 12 months = annualized percent of effort.
   - Save.
   - See example below:

3. Adjust (Manual Override) for automatic calculation.

   - Check ‘Allow Manual Override of Person Months’.
   - Let the screen refresh: The Person Months are now editable in each of the three columns – ACAD, CAL, and SUMR.
   - Enter the planned months in the appropriate columns.
     - CAL months cannot be combined with any other column.
     - Can combined ACAD and SUMR months or have months in only one of these two columns.
   - See results below for above example:
<table>
<thead>
<tr>
<th>Start Date</th>
<th>Months</th>
<th>End Date</th>
<th>Effort</th>
<th>Remove</th>
<th>Person Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Oct-2011</td>
<td>12</td>
<td>30-Sep-2012</td>
<td>70</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01-Oct-2012</td>
<td>24</td>
<td>30-Sep-2014</td>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oct-11 - Sep-12</td>
<td>70.00%</td>
<td>3.00</td>
<td></td>
<td>$119,956.00</td>
<td></td>
</tr>
<tr>
<td>Oct-12 - Sep-13</td>
<td>30.00%</td>
<td>2.00</td>
<td></td>
<td>48,537.72</td>
<td></td>
</tr>
<tr>
<td>Oct-13 - Sep-14</td>
<td>30.00%</td>
<td>2.00</td>
<td></td>
<td>49,993.85</td>
<td></td>
</tr>
<tr>
<td>Oct-11 - Sep-14</td>
<td>43.33%</td>
<td>7.00</td>
<td></td>
<td>$208,488.00</td>
<td></td>
</tr>
</tbody>
</table>
Using PD to develop the academic/summer appointment expense

When PennERA is used to create the budget without a pre-existing spreadsheet, use the steps below to calculate expense for academic/summer appointees.

1. Setup Questions
   - Choose “Budget by Total Project” budgeting model.

2. Budget Items
   - Open the Personnel folder to access the salary/effort screen for existing personnel or choose [Click to add] to add new personnel.

   • Click [Add Appointment] link.
3. Define the **Appointment** parameters:

- **For the Academic appointment, perform the following steps:**
  - Select the Appointment Type “ACAD” from the drop-down menu.
  - Type in number of months.
  - Select “Monthly” if you want the salary evenly distributed across each month.
    - **Note:** Base Salary must be entered as amount paid per month.
  - Enter a start date of 09/01/08 (start of the academic year in which the appointment begins).
  - Enter an end date of 05/31/09 (end of the academic year in which the appointment begins if this is a 9 month academic year).
  - Enter salary and benefits information. In this example, the salary for 9 months is $100,000.
  - Select Radio Button – “Recycle Salary on the Annual Anniversary” to reflect this salary information in each period of the proposal beginning 09/01.

- **For the Summer appointment, perform the following steps:**
  - Select the Appointment Type “SUMR” from the drop-down menu.
  - Type in number of months.
  - Select “Monthly” if you want the salary evenly distributed across each month.
    - **Note:** Base Salary must be entered as amount paid per month.
  - Enter a start date of 06/01/08 (start of the summer in which the appointment begins, not necessarily the date of the appointment).
  - Enter an end date of 08/31/08 (end of the summer in which the appointment begins).
  - Enter salary and benefits information. In this example, the summer salary is $33,333.
  - Select Radio Button – “Recycle Salary on the Annual Anniversary” to reflect this salary information in each period of the proposal beginning 09/01.

- Select Annual Inflation – “Cost of Living (3%)”.
4. Define the **Effort** parameters – Time and Effort section – enter the individual period.

- Define effort for the PI’s appointments (for example: 25% effort in Academic year, 75% effort during Summer session) as follows:

  - Since the project is scheduled to begin on 01/01/08, the first period you define will be 01/01/08 – 05/31/08 (start of the project to the end of the academic year). Enter 25% effort for this period.
  - The next period will be the summer appointment, so enter 06/01/08 - 08/31/08. Enter 75% for this period.
  - Click **Save** to add more Effort lines and calculate the data entered so far.
  - Next, you’ll enter a period covering the entire academic appointment. Enter 09/01/08 – 05/31/09. Enter 25% effort.
  - Now, enter the summer appointment, so enter 06/01/09 – 08/31/09. Enter 75% effort.
  - The final period to enter is 09/01/09 – 12/31/09. Enter 25% effort.

![Time and Effort levels on Project](image)

**Note:** If the effort is the same for both the Academic and Summer appointments, it is not necessary to repeatedly enter each year.

Some sponsors do not require separate budget calculations for investigators who hold Academic/Summer appointments (e.g., NIH). If the effort is the same throughout the budget period (or for all periods) and if the monthly salary does not change, except on the basis of annual inflation, then it is not necessary to complete an ACAD/SUMR appointment salary structure unless required by your department.
How do I... copy an existing proposal?

**Note:** This functionality is currently not available due to the major changes in NIH forms beginning in January 2010.

All of the information on a completed proposal can be copied to a new proposal. Changes to the new proposal can be made by making changes on the appropriate forms.

- From Navigation menu select [Proposals].
- Click [Create Proposal].
- Select “Copy From Existing Proposal”.
- Click [Continue to Next Step].
- Type in the original proposal number OR click the radio button next to the original proposal in the list.
- Put a check mark in “Include all Proposal Attachments”. **Tip:** Include attachments only if a significant number of the documents will be unchanged.
- Click [Continue to Next Step].
- Select whether this new proposal is “New Competing” or “Competitive Renewal”.
- Click [Continue to Next Step].
• Enter the Proposal’s Title for this new proposal.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>“New” or “Copy From Existing”?</th>
<th>Copy from Existing Proposal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>“New Competing” or “Competitive Renewal”?</td>
<td>Competitive Renewal</td>
</tr>
<tr>
<td>Step 3</td>
<td>Selected Sponsor</td>
<td>National Institute on Drug Abuse/NIH/ODDS</td>
</tr>
<tr>
<td>Step 4</td>
<td>“Tracking” Number or “Proposal” Number</td>
<td>This proposal will be automatically numbered.</td>
</tr>
</tbody>
</table>

Click [Continue to Next Step].

• The Project Start and End Dates and the Number of Budget Periods are copied from the original proposal.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>“New” or “Copy From Existing”?</th>
<th>Copy from Existing Proposal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>“New Competing” or “Competitive Renewal”?</td>
<td>Competitive Renewal</td>
</tr>
<tr>
<td>Step 3</td>
<td>Selected Sponsor</td>
<td>National Institute on Drug Abuse/NIH/ODDS</td>
</tr>
<tr>
<td>Step 4</td>
<td>“Tracking” Number or “Proposal” Number</td>
<td>This proposal will be automatically numbered.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Proposal’s Title</td>
<td>JMG Copy Proposal Information for manual</td>
</tr>
<tr>
<td>Step 6</td>
<td>Project Start and End Dates</td>
<td>01-Oct-2007 through 30-Sep-2012</td>
</tr>
<tr>
<td>Step 7</td>
<td>Number of Budget Periods</td>
<td>5</td>
</tr>
</tbody>
</table>

Is all of the above information correct? Yes, Create Proposal  No, Go back and make changes

Click [Yes, Create Proposal].

Copied Proposal

• Everything on the copied proposal will be the same as the original proposal.
• Each form on the Navigation Menu must be opened, necessary changes made, saved and the form completed.
• To make changes to the PI and budget information. See “How Do I Change the PI?” and “...Change Budget Periods and Project Period Start and End Dates?”
How do I... create Non-Personnel expenses for “Budget by Total Project”? 

- Select **Budget Items**.
- Select **Non-Personnel Expenses**.
  - Click on ![icon](image) or [Click to add].

  - Enter the Description of the expense – “Lab supplies”.
  - Select the **Budget/Charge Category** – “Supplies”.
  - Select **Annual Inflation** rate – “Cost of Living (3%)”.

  - Note there initially is only one line to enter the expense item. If necessary, additional blank lines will be added after each Save.
- **Example 1:**
  Total costs to the project are $20,000 (current value), or 1 unit @ $20,000 spread evenly over all budget periods.
  - **Units/Qty** – How many are you buying? Enter "1".
  - **Price/Charge** per units or total quantity information. Enter "$20,000".
  - Change **Charge Start Date** and **Charge End Date** to define the periods in which the cost will be incurred. Since the costs will be spread over all budget periods, in this example, you only need to change the end date to 03/31/10.
  - Click **Save**, to calculate the **Costs by "Budget Period"** section.

### Purchase/Usage Schedule

<table>
<thead>
<tr>
<th>Units/Qty</th>
<th>Price/Charge Each</th>
<th>Total</th>
<th>Charge Start Date</th>
<th>Charge End Date</th>
<th>Remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20,000.00</td>
<td>20,000.00</td>
<td>01-Apr-2008</td>
<td>31-Mar-2010</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Costs by "Budget Period"

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Cost to Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Apr-2008</td>
<td>31-Mar-2009</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>2</td>
<td>01-Apr-2009</td>
<td>31-Mar-2010</td>
<td>10,000.00</td>
</tr>
<tr>
<td><strong>ALL</strong></td>
<td><strong>01-Apr-2008</strong></td>
<td><strong>31-Mar-2010</strong></td>
<td><strong>$20,000.00</strong></td>
</tr>
</tbody>
</table>

This example could also have been entered as 2 units (years) @ $10,000 annual costs.

### Purchase/Usage Schedule

<table>
<thead>
<tr>
<th>Units/Qty</th>
<th>Price/Charge Each</th>
<th>Total</th>
<th>Charge Start Date</th>
<th>Charge End Date</th>
<th>Remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>10,000.00</td>
<td>20,000.00</td>
<td>01-Apr-2008</td>
<td>31-Mar-2010</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Costs by "Budget Period"

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Cost to Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Apr-2008</td>
<td>31-Mar-2009</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>2</td>
<td>01-Apr-2009</td>
<td>31-Mar-2010</td>
<td>10,000.00</td>
</tr>
<tr>
<td><strong>ALL</strong></td>
<td><strong>01-Apr-2008</strong></td>
<td><strong>31-Mar-2010</strong></td>
<td><strong>$20,000.00</strong></td>
</tr>
</tbody>
</table>

- **Example 2:**
  Costs to the project are $10,000 in the first budget period, but only $5,000 in the second.
  - **Units/Qty** – Enter “1” for each budget period.
  - **Price/Charge** – Enter "$10,000" and "$5,000" in the appropriate periods.
  - **Charge Start Date** and **Charge End Date** – Change the end date for the first item to 03/31/09 (first budget period); dates for the second item are 04/01/09 and 03/31/10.
  - Click **Save**, to calculate the **Costs by "Budget Period"** section.

### Purchase/Usage Schedule

<table>
<thead>
<tr>
<th>Units/Qty</th>
<th>Price/Charge Each</th>
<th>Total</th>
<th>Charge Start Date</th>
<th>Charge End Date</th>
<th>Remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10,000.00</td>
<td>10,000.00</td>
<td>01-Apr-2008</td>
<td>31-Mar-2009</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>5,000.00</td>
<td>5,000.00</td>
<td>01-Apr-2009</td>
<td>31-Mar-2010</td>
<td></td>
</tr>
</tbody>
</table>

### Costs by "Budget Period"

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Cost to Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Apr-2008</td>
<td>31-Mar-2009</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>2</td>
<td>01-Apr-2009</td>
<td>31-Mar-2010</td>
<td>5,150.00</td>
</tr>
<tr>
<td><strong>ALL</strong></td>
<td><strong>01-Apr-2008</strong></td>
<td><strong>31-Mar-2010</strong></td>
<td><strong>$15,150.00</strong></td>
</tr>
</tbody>
</table>
How do I... manually adjust F&A?

Note: This method was developed in order to correctly enter graduate student tuition expense in research projects and populate the correct section of the 424 R&R Detailed Budget. As of December 2010, this method of calculation is no longer necessary for tuition on a research project, but this general methodology can be used for other situations requiring a manual calculation for a specific expense item.

Certain expenses do not require F&A, but there is no appropriate Budget Category to select. The F&A cost for these items must be manually adjusted. This method can be used for either simple modular budgets or for detailed budgets.

- Create an expense line in Non-Personnel Costs section of Budget Items.
- Click Save.

Budget Detail for: Graduate student tuition

<table>
<thead>
<tr>
<th>Description</th>
<th>Budget/Charge Category</th>
<th>Notes about item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graduate student tuition</td>
<td>Other Costs *</td>
<td></td>
</tr>
</tbody>
</table>

Annual Inflation

Cost of Living (%)

Budget Justification

Please enter your justification below.

Purchase/Usage Schedule

<table>
<thead>
<tr>
<th>Units/Qty</th>
<th>Price/Charge Each</th>
<th>Total</th>
<th>Start Date</th>
<th>End Date</th>
<th>Remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10,000.00</td>
<td>20,000.00</td>
<td>01-Apr-2008</td>
<td>31-Mar-2009</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Costs by “Budget Period”

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Cost to Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Apr-2008</td>
<td>31-Mar-2009</td>
<td>$16,000.00</td>
</tr>
<tr>
<td>2</td>
<td>01-Apr-2009</td>
<td>31-Mar-2010</td>
<td>$16,000.00</td>
</tr>
<tr>
<td>ALL</td>
<td>01-Apr-2008</td>
<td>31-Mar-2010</td>
<td>$32,000.00</td>
</tr>
</tbody>
</table>

- Add additional expenditures as required
- Click “Completed” box for Budget Items

Budget Item

“Initial” Budget Version

<table>
<thead>
<tr>
<th>Person</th>
<th>Name / Rank</th>
<th>Type</th>
<th>Effort</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRATTIARD, STEPHEN ADP</td>
<td></td>
<td>Key</td>
<td>25.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>BENOFF, STUART</td>
<td></td>
<td>Key</td>
<td>10.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>- Senior, Tutor</td>
<td></td>
<td>Key</td>
<td>5.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Non-Personnel Costs

<table>
<thead>
<tr>
<th>Open Budget Category</th>
<th>Item</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Costs</td>
<td>Graduate student tuition</td>
<td>$10,000.00</td>
<td>$10,000.00</td>
<td>$20,000.00</td>
</tr>
<tr>
<td>Other Costs</td>
<td>Total Direct Expenses</td>
<td>$125,000.00</td>
<td>$150,000.00</td>
<td>$275,000.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$135,000.00</td>
</tr>
</tbody>
</table>

Final | $135,000.00 | $160,000.00 | $295,000.00 |
- Select **Budget > F&A**
- Select **Manual (line by line)**

### Facilities and Administration Costs

<table>
<thead>
<tr>
<th>Institution Base/Target Scheme</th>
<th>Research On-Campus Scheme</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Manual (line by line)</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Personnel Costs

<table>
<thead>
<tr>
<th></th>
<th>Manual</th>
<th>Total</th>
<th>Manual</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto (predefined schemes)</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Auto (predefined bases/rates)</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Manual (lump sum by period)</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

#### Sponsors F&A Base

<table>
<thead>
<tr>
<th></th>
<th>Manual</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto (predefined schemes)</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Auto (predefined bases/rates)</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Manual (lump sum by period)</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

#### Sponsors F&A Base

<table>
<thead>
<tr>
<th></th>
<th>Manual</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto (predefined schemes)</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Auto (predefined bases/rates)</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Manual (lump sum by period)</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Tip:** Just delete the values before saving; empty cells will be replaced with "0.00" during **Save**.
- Click **Save**.
- Click "Completed" box for **F&A**.
Note: Drift = difference between automatic F&A calculation and manual F&A calculation.

Select Budget > Cost Sharing

Check the Indirect Costs > Inst line: There should be no values displayed. If the drift (see above) is shown here, it must be removed and copied into the Indirect Costs > UnAllow line.

Tip: Values in the Inst cost-sharing fields can be copied and then pasted into the UnAllow fields.
• Click [Save CS Data].

<table>
<thead>
<tr>
<th>Setup Questions</th>
<th>Cost Sharing</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF424 (R&amp;R)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Performance Sites</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Project Info</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Narrative</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference Cited</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Attachments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personnel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Budget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Budget Items</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P&amp;F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cost Sharing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modular Budget Justifications</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Budget Periods and Setups</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHS 399 Cover Page</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHS 399 Research Plan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PHS 399 Checklist</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approvals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finalize</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Cost Sharing**

<table>
<thead>
<tr>
<th>Add/Edit Sources</th>
<th>Completed</th>
</tr>
</thead>
</table>

  - **Who will be responsible for any cost sharing that may occur on the project?**
    - **8700 - Research Services**
    - **Set**
    - **Who will be responsible for project costs that might not be reimbursable/allowable by the sponsor?**
      - **8700 - Research Services**
      - **Set**

  - **Does this program/application have any funding rules/ceilings?**
    - Yes ☐ No ☑

  - **Does the sponsor expect any financial contribution from your institution?**
    - Yes ☐ No ☑

- **Other funding guidelines/restriictions/information:**

- **Personnel Costs**

<table>
<thead>
<tr>
<th>Personnel Costs</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Line Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRATANARO, STEPHEN</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

• Click “Completed” box.
How do I... use 424 budgeting?

[Last updated June 2008.]

The 424 budgeting model is designed for users who have already calculated their budgets in Excel spreadsheets and only want to enter that data directly into Proposal Development (PD). Users who plan to develop their budgets in PD should continue to choose "Budget by Total Project" or "Budget Period by Period".

Overview

- Data entry only
  - Adds rows and columns
  - Calculates project totals and F&A
  - Does not calculate inflationary increases
  - Does not calculate fringe benefits
  - Does not evaluate for any salary cap
- Modular or detail budgets
- Warns and/or prevents completion of budgets that exceed sponsor limits (e.g., modular budgets)
- CAL, ACAD, and SUMR appointments
- Institutional Base Salary (IBS) may be left blank

Note: Some sponsors, e.g., NIH, may permit applicants to not display the institutional base salary when it exceeds a salary cap. Be sure that the sponsor for your proposal allows this.

Some screens and processes are identical in all three budgeting models:

- Budget Items, F&A, Cost Sharing, Modular Budget, and Justification screens are unchanged.
- Adding existing or TBN staff records are still initially created from an alpha-split list.

Setup Questions

- Will this proposal be using a Modular budget? Click "Yes" or "No".
- In Budget Setup Information choose "424 Budgeting" from the drop-down list.

Each proposal is broken down into several sections based upon what the sponsor and your institution requires. Once each section is completed, the Completed checkbox in the upper right corner of that section. When all sections have been completed, you will be able to continue.

Submission Mechanism/Form Information

Budget Setup Information

What kind of budgeting model would you like to use?

424 Budgeting

Is this a flow through Project? Yes No

Select the Program Type: Upenn - Research

The majority of the research will be conducted: On campus.
Budget > Budget Periods and Setups

The budgeting type can be changed in **Budget Periods and Setups**. If budget information has already been entered, be sure to carefully check all **Budget Items** to ensure that expenses are still correct.

- Choose “424 Budgeting” from the drop-down list.
- Click **Save** at the top of the screen.

Budget > Budget Items

- Costs are entered in one of three main sections:
  - Personnel Costs
  - Non-Personnel Costs
  - Subcontractors
- If this is a modular budget, the “Modular Budget” section will also be available.
Personnel Costs

- Select [Click to add] to add additional personnel or choose next to an existing name to open a detail screen.
- Verify that the Personnel Type and Role on Project sections are complete and accurate.

- Enter Base Salary, Months, Salary, and Fringe Benefits values.
  - Fringe Benefits will not calculate – must be entered correctly by user.
  - NIH salary cap also will not be calculated against the true Base Salary.
  - If the number of months is < 0, user must type the leading zero and the decimal point.
  - Remember to calculate inflationary increases.
- Total rows and Grand Total columns will be calculated by PD.
- Click Save at the top of the screen.

Continue adding personnel and then return to Budget Items.
Non-Personnel Costs

Select [Click to add] to add new items or choose next to an item to open a detail screen.

- Complete Description.
- Select Sponsor Budget Category from list.  
  ◦ F&A will be calculated by PD, so remember to choose the correct category.
- Enter Cost to Project for each budget period.  
  ◦ Remember to include inflationary increases if you wish.
- Click Save at the top of the screen.

Continue adding items and then return to Budget Items.
Subcontractors

- Select [Click to add] to create a new subcontract or choose under Detail Budgeting to open a detail screen.

The Budget Items and Budget Detail screens and data entry for subcontracts are identical to the previous instructions for the primary applicant.

- Complete budget entry for the subcontractor.
- Remember to also complete the F&A.
Modular Budgets

Simplified data entry may be used for modular budgets when the 424 budgeting method is chosen.

- **Personnel Costs**
  - Effort, Personnel Type (e.g., Key, etc.), and Role on Project are the only required information for each Key Personnel or Significant Contributor working on the project.

- **Non-Personnel Costs**
  - Users may enter one line item for the project’s total direct costs.
  - Exclude subcontractor expense, equipment, graduate student tuition and any other item that does not incur F&A expense. These need to be entered separately.

- **Subcontractors**
  - Simplified data entry for Personnel and Non-Personnel Costs may be used as described above.

Completing the Budget

The remaining sections of the budget – F&A Cost Sharing, Modular Budget (if not a detailed budget), and Justifications – are completed in the same way as the other budgeting methods.
How do I... print a copy of my proposal?

A user can print a copy of their proposal by accessing the proposal through Proposal Development, and selecting the “Finalize” tab from the left-hand navigation menu. Then, select the “Eyeglasses” icon under the heading “Completed Form” to view a PDF version of the proposal. At this point, the user may print out the PDF document or save it to his/her computer.

How do I... view a proposal I’ve been working on?

There are a number of ways to view proposals. The first and possibly the easiest way is to log in to PennERA, select “Proposals” from the left-hand navigation menu, type in the Institution number, and select “Go.” This will display the specific proposal in question.

Since an Investigator has access to only their proposals, selecting “Proposals” will display all of his/her proposals. Select the appropriate proposal from the list.

Administrators have access to all proposals in a particular ORG(s). Select “Proposals” from the left-hand navigation menu, and select either “All Status” or “Advanced Search” to search for the desired proposal from a number of options such as Principal Investigator, Institution Number, Sponsor, etc.

How do I... determine where a proposal is that’s been submitted for internal review?

A user can determine where a proposal is in its defined Routing and Approval path by accessing the proposal through Proposal Development, and selecting the “Finalize” tab from the left-hand navigation menu.

Proposal > [icon] > Finalize
Appendix B: Best Business Practices

Naming Conventions for files to be uploaded
- Create separate folders for the attachments needed for each proposal
- Name Word Documents and PDF files similar to those in Proposal Development (Summary, Aims, etc.) to make them easier to retrieve

Working Collaboratively Across Schools
- Security for Proposals is established by central administrators.
- PIs have access to all proposal on which they are the Primary Investigator
- Business Administrators have access to proposals that are submitted under their ORG numbers
- If working with another School/Center or non-authorized ORG, users can designate authority to others
- From the Navigation Menu select Profile > Delegation > [Add] and select the person you will be working with on the proposal. Determine if they are to have View or Edit access to your proposals.
# Appendix C: Document Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Page Number(s)/Sections</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>October 2006</td>
<td>All</td>
<td>Initial Distribution for Pilot</td>
</tr>
<tr>
<td>February 13, 2007</td>
<td>Many</td>
<td>Revised for Implementation – recommend that entire document be reprinted.</td>
</tr>
<tr>
<td>May 6, 2007</td>
<td>Many</td>
<td>Revised information; added budget information for adding appointments and non-personnel expenses for Budget by Period budgets.</td>
</tr>
<tr>
<td>October 2007</td>
<td>Many</td>
<td></td>
</tr>
<tr>
<td>June 2008</td>
<td>Many</td>
<td>Revised to include screen changes</td>
</tr>
<tr>
<td>December 2010</td>
<td>Many</td>
<td>Updated for version 09.801.06 changes (January 2010) and 12.802.03 software upgrade (December 2010)</td>
</tr>
<tr>
<td>July 2012</td>
<td>pp 54-56</td>
<td>Updated for version 12.803.01 software upgrade (July 2012)</td>
</tr>
<tr>
<td></td>
<td>pp 79-81</td>
<td></td>
</tr>
</tbody>
</table>
FAQ

PennERA Proposal Development Frequently Asked Questions (FAQs)

Questions

- Where can I find out how to do things in PD that I’ve forgotten from training and aren’t questions in this FAQ?
- The department (ORG) that is going to manage the grant is different from the PI’s Home Dept and the department showing as the Primary Associated Department, how do you change the Primary Associated Department?
- Many folks work on grants in my department, who should start the proposal and generate the PennERA Proposal ID#?
- My PI can’t remember their PennKey and password, how do they reset their password?
- How can I download and save a copy of the proposal on my PC?
- There is a proposal that needs the Department Chair’s approval but she is on vacation and never granted “designee” authority to anyone in PD? How can this proposal be approved?
- The PI created the proposal and answered the set-up questions. It turns out the wrong Program Announcement/funding opportunity was selected. How can the Program Announcement/funding opportunity be changed to the correct one without losing all my work?
- Where can I find out if a proposal should be created and submitted using PennERA Proposal Development (PD)?

Q: Where can I find out how to do things in PD that I’ve forgotten from training and aren’t questions in this FAQ?

Answer: Go to the PennERA website [https://www.pennera.upenn.edu/](https://www.pennera.upenn.edu/), click on PennERA Proposals and Awards and then select Proposal Development and Reference Materials. After authenticating with your PennKey and password, the first item listed on the page is the Proposal Development Training Guide

Q: The department (ORG) that is going to manage the grant is different from the PI’s Home Dept and the department showing as the Primary Associated Department, how do you change the Primary Associated Department?

Answer: Select the Setup Questions tab in the proposal and then in General Proposal Properties section of the screen, click on the Add link just to the right of Associated Departments. This will launch a "Departments" window. In this new window, choose the desired ORG value from the list of values pull-down just under the alphabetic split. When the ORG value you want is highlighted, click the Select button at the top right of the window.

This will return you to the Setup Questions screen and the ORG value with description will have been added to the list of Associated Departments for this proposal. If you want this newly added value to be the Prime Associated Department, click the Prime radio button to the right of the ORG description. Next click the Save icon in the upper left corner of the screen. The screen will refresh as it saves and the new ORG will now be listed first in the list with Prime radio button selected.

The original ORG value can remain in the list of Associated Departments if appropriate or by clicking the Remove icon , the old ORG can be removed from the list of Associated Departments for this proposal.

Q: Many folks work on grants in my department, who should start the proposal and generate the PennERA Proposal ID#?

Answer: There is no one correct answer to this question. Different organizations within the University do business in different ways. What works best in one organization may not be the best choice for another. If your School/Center has given instructions that the proposal create step should be done by an individual with a specific role (for example the PI or the BA), please follow those instructions.

The most important point is that regardless of whether the original proposal record is created by the PI or by staff, communications between those involved is essential. All those involved in the proposal process in your
area should understand who will create the record and when it then is available. The individual who does create the original proposal record, should be sure that both the PI and the Primary Associated Department are assigned correctly to the record. This helps ensure that the appropriate secured access is available to those who need it.

**Q:** My PI can't remember their PennKey and password, how do they reset their password?  
**Answer:** If you do not have a PennKey, or if you have a PennKey but forgot your password, go to the PennKey web site for more information at [http://www.upenn.edu/computing/pennkey/](http://www.upenn.edu/computing/pennkey/). If you have any trouble with the PennKey process, contact your Local Support Provider. For a contact list, go to [http://www.upenn.edu/computing/view/support/](http://www.upenn.edu/computing/view/support/).

**Q:** How can I download and save a copy of the proposal on my PC?  
**Answer:** The proposal can be downloaded (or viewed or printed in its entirety) only after all the Tabs on the proposal have been completed and on the **Finalize** screen, the pdf for each of the **Form Pages** has been built and the **Assemble Application** has been completed.

On the **Finalize** screen, go to the **Submit for Internal Review** section. Under the Components for **Initial Application** subsection, Proposal is listed. On the Proposal line, click on the "View" icon for the **Completed Form**, it will launch a window containing a pdf rendering of the entire proposal. The proposal pdf can then be saved, printed or viewed by selecting the corresponding Adobe Acrobat/Reader icons (diskette, printer or page navigation arrows) from the window's toolbar.

**Q:** There is a proposal that needs the Department Chair’s approval but she is on vacation and never granted "designee" authority to anyone in PD? How can this proposal be approved?  
**Answer:** By contacting the central or tier 2 PennERA End User Support group using the web form on the PennERA website (accessed through the Help page at [http://project.pennera.upenn.edu/help.asp](http://project.pennera.upenn.edu/help.asp)), the **Support** icon in the PennERA application or via email (pennerahelp@pobox.upenn.edu) and describing the situation and the proposal and Department in question. Module Administrators can then bypass the Department Chair approval step for this proposal, moving it forward in the approval process. Each School/Center will need to decide if, in their view, the proposal should be approved and move on to Research Services and eventual submission prior to obtaining the Department Chair’s approval.

**Q:** The PI created the proposal and answered the set-up questions. It turns out the wrong Program Announcement/funding opportunity was selected. How can the Program Announcement/funding opportunity be changed to the correct one without losing all my work?  
**Answer:** Select the **Setup Questions** tab in the proposal and then in the **Submission Mechanism/Form Information** section, be sure that the correct proposal mechanism appears under **Select Mechanism**. If not, choose the appropriate proposal mechanism from the **Select Mechanism** list-of-values pull-down. When the correct proposal mechanism has been selected, click the **Get Opportunity Number** link just below the mechanism value. This will launch the "Get Opportunity Number" window from which the correct funding opportunity can be chosen by checking the box to the left of the appropriate opportunity listing and clicking the **Select** button in the upper right of the window.

The **Setup Questions** screen will refresh with the new Program/Opportunity Number, along with the accompanying submission and validation information throughout the screen.

It would be prudent to review the entire PD proposal for possible impact to each section that changing the Program Announcement/funding opportunity could have to data validations and enforcement of sponsor/mechanism rules.

**Q:** Where can I find out if a proposal should be created and submitted using PennERA Proposal Development (PD)?  
**Answer:** The up-to-date list of sponsors and mechanisms for which PennERA Proposal Development (PD) can currently be used is always available on the PennERA web site at [http://project.pennera.upenn.edu/project/current_phase/PDfundingopps.pdf](http://project.pennera.upenn.edu/project/current_phase/PDfundingopps.pdf)